
liACTIVISION.il 
© 1989 Activision 

K-168-03 

I 

Teleworks Plus' 
Contn1unications Sq{tlvare 
for the AjJple l/c;s'' 

IIACTIVISION.il 



Thleworks PlusN 
Commtmications Software 

for the Apple· Del 

Credits 
Teleworks Plus was developed by Version Soft, Inc. 

Produced by Paul Zuzelo. 

Product management by Sharon Giordano. 

Product testing by Dan Rines and Kelly Zrnak. 

User's Guide by Jeff Schwarnberger. Editorial management by 
Steven Young and Kitty Haller. Production by GlennHills 
Graphics Company. 

For a recorded message about our newest software, call 415/329-7699. 
For technical help, call Technical Support between 9 :00 a.m. and 4:30 
p.m. Pacific time, Monday through Friday: 415/329-7699. 

For information about our products, write to: 

Product Support 
Activision 

P.O. Box 3048 
Menlo Park, CA 94025-3048 

For the best service, be sure to note the subject of your inquiry on the 
outside of the envelope. 

Copying Prohibited 
This software product is copyrighted and all rights are reserved by the 
copyright holder. The distribution and sale of this product are intended 
for the use of the original purchaser only and for use only on the computer 
system specified. Copying this product for sale or distribution without ex
press written permission of the copyright holder is a violation of U.S. 
Copyright Law and is hereby expressly forbidden. 

© 1989 Activlsion. All rights reserved. 

Teleworks Plus, Writer 's Choice elite, List Plus, Draw Plus, and Patntworks Gold are 
trademarks of Activision. 

Apple, Macintosh, ImageWriter, LaserWriter, and AppleTalk are registered trademarks of 
Apple Computer, Inc. IIGs is a trademark of Apple Computer, Inc. 



Teleworks Plus 

_________ Contents 

Introduction ...................... .... .. . ... . ..... ... 1 
How to Use this Guide ................................ ... 2 
What You'll Need .......... .... ... ........... .... ...... 2 
Making a Back-up Copy .................................. 2 
Using the Mouse .... .. ............................. .... 4 
The Command Key ... .. . ...... ..... . . ... ... ...... ... . . . 5 
A Note on Type Styles . ... . .. ... .. .. . ... .. ... . ........ . .. 5 

A Guided Tour 
Chapter 1-Getting Started ........... .. . ............ 7 

Setting Up Your Modem . .. ... . ....... ................ 7 
Starting Teleworks Plus . .......... ......... .... ...... . 7 
The Screen ........ .. .. ... . . .................... .. . 9 

The Menu Bar .. ... ..... . . . .... . .. .. ... .. ....... . . 9 
The Counters .. . ............. ...... ........... .. 10 
The Communications Area . . . .... . .......... ..... .. 11 

The Keyboard .. ....... ...... ... . . ... ... ... ........ 12 
Setting Up TeleworksPlus ..... . . .... . ....... . ........ 13 
Quitting Teleworks Plus ..... . ..... .. . . . .. .. .. . ... ... 14 

Chapter 2-Signing On .. . . . .. ...... ... . ........... 15 
Checking Compatibility .... .. . ...... .......... . . .... 15 
Before Dialing ........ ...... . ... .. . .. ............. 16 

Dialing an Outside Line .. ..... . .................... 16 
Disabling Call Waiting . ..... ...... ... .. . .. .. ....... 16 

Dialing a Number ....... . ....... ... .. . . . ....... .... 17 
Signing On .. . . .. .. ....... . ...... .. ...... .. ..... . . 18 
Signing Off . .... . ..... , •. .... . . . ....... .. . ......... 19 
Hanging Up . .. ....... .. .. . . .. ......... .. ......... 20 
Saving the Current Setup .... .... ....... ............. . 20 

"------------------------------------------ --------------------------------------------------ill 



Teleworks Plus 

Chapter 3-Editing, Saving, and Printing ....... . . .. 21 
Reviewing a Session ... . .. . . .......... .. ...... .. . ... 21 
Editing the Test in Memory . .... .. . ...... ... .......... 21 
Erasing Text ..... . .... ... .... .. . .............. · . · · 21 
Copying Text ...................... . . ...... .. . . ... 2 2 
Pasting Text ...... . . .... . . ... . .. . ............. · . . · 22 
Saving Information . ... . . . ........ . .... .......... . . · 23 
Printing Information .. .. . . .... .. ..... . . ....... .... · · 24 

Printing During a Session .... .... .. ......... .. . . .. . 24 

Chapter 4-Creating and Using Procedures . .. .... .. 25 
Recording a Procedure ....... . . . . .. . .. ..... . . .... .. · 2 5 

Waiting for a Prompt .. . . ........ .. . . .. .. ... . .. .. · 26 
Editing a Procedure ... .. . .... ... ....... .... .. · · . · · · · 28 
Writing a Procedure . ................. .... ..... .... · 29 

Procedure Commands .. ............... . .... · .. · · · 29 
Punctuation ... ...... .. .. . ...... . ........ · · . · · · · 29 
Syntax .......... .. ... ........ . . . . · . · · · · · · · · · · · 29 
Creating a Sign-off Procedure . .. ... ...... . ... . . . ... · 30 

RunningaProcedure . .... ........ . ..... . .. . . .. ·. · · · . 32 

Chapter 5 -Sending and Receiving Files . .... . ... . ... 33 
Receiving Files . ... ....... . . ... . .. .. . .. . · · · · · · · · · · · 33 

Setting Up the Protocol . . ........ .. .. .. ... ..... . .. · 33 
Selecting a File ...... . ... . ... . .. ......... . .. ... . . 34 
Starting the Transfer . .... ..... . .. ......... . ...... · 35 
Saving the File .. .. . .. .... . . .. . . . . . . . . . ..... . · · · · 35 

Sending a File .......... . . . ..... ... . .. . ... · · · · · · · · · 36 
Setting Up a Protocol .. ...... . ... . .. . . . . .. . .. . . . . . 37 
Starting the Transfer ... ... .. . . .... .. . . . .. . . ... . .. · 3 7 

Reference 
You'll find a detailed table of contents for this section starting 
on page 39. 

Glossary .......... . .. .. . ........... ... .. . ...... . .. . · 73 

Appendix A-Procedure Commands .. .. . ...... . . . .. 81 

Appendix B-Error Messages .. . . . .. . . ... .... . . .. . . · 87 

Index . ......... ......... .. .. . ... . ... . . . ....... .... . . . 89 

N--------------------------------------------------

______ Introduction 

Teleworks Plus, together with your Apple IIGS and a modem, provides you 
with an efficient way to communicate with on-line information services 
such as CompuServe, Delphi, Dow Jones News/Retrieval, MCI Mail, and 
The Source. You can also use Teleworks Plus to communicate with just 
about any other personal computer that' s also equipped with a modem 
and standard telecommunications software. You can communicate not 
just with another Apple IIGS, but also with an Apple II, II+ , lie, or lie, a 
Macintosh~ or even an MS-DOS computer. 

What makes using Teleworks Plus efficient is the many ordinary tasks it 
takes care of for you. For example, you can have Teleworks Plus not just 
dial the phone number of the service or other computer you want to com
municate with, you can also have it automatically sign you on to the ser
vice. Teleworks Plus can, in fact, record and reproduce just about any 
series of actions you can carry out using the keyboard or the menus. You 
can, for example, have Teleworks Plus dial The Source, sign on, check the 
latest stock market quotes, save them, sign off, and hang up the phone-all 
automatically. You never have to go through a complicated procedure 
more than a single time-once Teleworks Plus has recorded it, it will ac
curately repeat the procedure step by step. Teleworks Plus also lets you 
edit procedures it has recorded, so that if a small part of a procedure 
changes, you don't have to record the entire procedure again to change it. 

You can also set up Teleworks Plus to allow your computer to act as a 
host-that is, to allow other computers to call yours to leave messages for 
you, copy files you've saved, or send files to you. When you set up your 
computer as a host, Teleworks Plus waits for the phone to ring and 
answers it automatically when it does. 

Teleworks Plus also has some of the features of a word processor. You can 
create memos and letters; cut, copy, and paste text in them; save them, 
print them, and send them to the t:omputer or service you're connected 
to. You can record any text that appears on the screen during a com
munications session, save it, and edit it just as if you had typed it yourself. 
You can also send and receive documents that have been created with a 
word processor such as Writer's Choice elite!M 
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How to Use this Guide 
This guide has four sections. 

"A Guided Tour of Teleworks Plus" takes you through the basic features 
of Teleworks Plus. It lets you experiment with the program and become 
familiar with how it works. 

The "Reference" section covers every aspect of Teleworks Plus. It's the 
place to find anything that isn't covered in the guided tour. The 
''Reference'' section is organized by the way things appear on the screen: 
the menu functions are listed according to the menu they appear on. 

The "Appendix" has two parts. Appendix A, "Procedure Commands" 
lists the commands you can use in writing or editing a procedure. Appen
dix B, "Error Messages" lists and explains the error messages you might 
receive. 

The "Glossary" lists and defines special terms used in the guide that you 
may not know. 

What You'll Need 
• An Apple IIGS with at least 768K RAM. 

• At least one 3 112 inch disk drive. 

• A blank initialized disk. It's always best to save the files you create on a 
disk other than the Teleworks Plus program disk. 

• A printer, if you want to make printed copies of the files you create. 

(Refer to the sticker on the box for specific system requirements.) 

Making a Back-up Copy 
The Teleworks Plus disk isn't copy-protected, so you can install it on a 
hard disk or make a back-up copy of it for your use only. 

Keep the original Teleworks Plus disk in a safe place and use the back-up 
copy for everyday use; that way you won't risk damaging your original. 
And remember, you must be a registered owner to be eligible for support 
and program updates. 
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To make a back-up copy on a floppy disk: 

1. If your computer isn't on, put the Teleworks Plus application disk in 
drive 1, then turn on the computer. If your computer is already on, go 
to the Finder. 

The Finder appears on the screen. 

2. If you have two disk drives, put a blank disk in drive 2. 

If you have a single disk drive, choose Eject from the Special menu to 
eject the Teleworks Plus application disk, and replace it with a blank 
disk. (Don't drag the icon of the disk to the Trash Can to eject it; use 
the Eject command so the disk icon remains on the screen.) 

3. If the blank disk you're using isn't initialized, a message box appears 
that asks you if you want to initialize it. Click the Initialize button. A 
dialog box appears that asks you to name the disk. Type Teleworks 
Backup, and click OK. 

When the disk is initialized, an icon representing the disk apepars on 
the desktop. 

4. Point to the icon of the Teleworks Plus application disk, hold down 
the mouse button, and drag the outline of the disk to the icon of the 
Teleworks Backup disk. Release the mouse button. 

A dialog box appears that asks if you want to completely replace the 
contents of the initialized disk. 

5. Click OK. 

If you have a single disk drive, the Finder prompts you to switch disks. 

A message box appears that tells you how many blocks remain to be 
copied. The process takes a little over a minute (it takes longer if you 
have a single disk drive). When the message box disappears, the pro
cess is complete. 
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To copy Teleworks Plus onto a hard disk: 

1. If your computer isn' t on, put the Teleworks Plus application disk in 
drive 1, then turn on the computer. If your computer is already on, go 
to the Finder. 

The Finder appears on the screen. 

2. Put the Teleworks Plus application disk in the disk drive. 

3. Double-click both the hard disk icon and the Teleworks Plus applica
tion disk icon to open them. 

4 . Click the title bar of the hard disk window to make it active, then 
choose New Folder from the File menu. When the new folder ap
pears, name it TELEWORKS. 

5. Copy TELEWORKS.SYS16 and STARTUPSCREEN from the 
Teleworks Plus application disk to the folder you just created on the 
hard disk. 

Using the Mouse 
This guide uses four terms to designate the different ways you can use the 
mouse. Here's what the terms mean: 

Click means position the pointer and then press and quickly release the 
button on the mouse. 

Double-click means position the pointer and then press and quickly 
release the mouse button twice. 

Drag means position the pointer and hold the mouse button down while 
you move the mouse. You release the mouse button to choose a menu item 
or when you reach the end of the text you're selecting. 

Press means position the pointer and then hold down the mouse button 
without moving the mouse. 
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The Command Key 
Throughout this guide, keys are referred to by the name printed on them. 
This key 

is called the command key. 

A Note on Type Styles 
In this guide, boldface type is used for words and messages that appear 
on the screen. Boldface is also used for words you're supposed to type or 
keys you're supposed to press. For example, 

Press delete 

means that you're to press the key that has the word delete printed on it. 

Terms that appear in italics are explained in the Glossary. 
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A Guided Tour 
Chapter 1 

Getting Started 

Setting Up Your Modem 
If you haven't set up your modem yet, do so before you go on. When you 
set up your modem, follow the instructions in the user's guide that came 
with it. You may also need to install an interface card in your computer 
before you can connect the modem to it. 

Starting Teleworks Plus 
There are two ways to start Teleworks Plus. The method you use depends 
on whether your computer is off or whether it's on and the Finder is on 
the screen. 

If the computer is off: 
1. If you have a printer, be sure it's off. 

2 . Turn on the monitor, but not the computer. 

3 . Put the Teleworks Plus back-up disk in the disk drive with the label 
side up. 

4. Turn on the computer (and your printer, if you have one). The Finder 
loads into the computer. After a few moments, the Finder appears on 
the screen. It looks like this: 

Select the fiiJ! uou wont to open: 
§ / Teleworts. Vl.O/ 

~ PROOOS i} ( Dist ) 
DSYSTEM 

' ~ 
' 

[ Open ~ 
( C1D>:>) ) 

~ ( Quit ) 
Version 2.1 
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s. Double-dick the icon of Teleworks Plus disk to open it. 

6. Double-dick TELEWORKS.SYS16 to start Teleworks Plus. 

After a minute or two, the title screen appears and then the work area. 

The screen. should look like the illustration on page 9 . 

If the Finder is on the screen: 
1. The screen looks something like this: 

Select the file uou wont to open: 
raJ /TelewOf(s.V 1.0/ 

~PROOOS {)' 
DS'ISTEM 

~ 

~ 
Version 2.1 

( DiS( ) 

( Open ] 
( [:1 ;:;:;: ) 

( Quit ) 

2. If the Teleworks Plus back-up disk isn't in the drive, eject the disk 
that's there and replace it with the Teleworks Plus disk, label side up. 
Then position the pointer on the Disk button and click the mouse 
button. In a moment, a new list of names appears on the screen. 

Note: Don't eject a disk when the disk drive is running. Wait until the 
drive stops, then eject the disk. 
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3. Double-click the icon of the Teleworks Plus disk to open it. 

4. Double-click TELEWORKS.SYS 16 to start Teleworks Plus. 

After a minute or two, the title screen appears and then the work area. 

The screen should look like this: 

Menu Bar 
Time and Memory Counters 

Communications Area 

o File Edit Communication Procedures Setup Binaryll 
·:u"n oo;oo;oo Free : so2 K 

Teleworks Plus is now ready for you to use. 

The Screen 
Teleworks Plus' screen has four elements: a menu bar, time and memory 
counters, and a communications area. They provide you with everything 
you need to communicate with on-line services or other computers-from 
dialing the phone to creating procedures you can use to run your com
munications sessions automatically. 

The Menu Bar 
Look at the top line on the screert. It looks like this: 

·, I 0 File Edit Communication Procedures Setup Binary I! 
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The menu bar contains the seven menus you can choose from when you're 
using Teleworks Plus. To see the commands each of the menus contain, hold 
down the mouse button and point to the name of each menu in tum. 

The Apple menu gives you information about the version of Teleworks 
Plus you're using. See the "Reference" section for more information 
about it. 

The File menu contains the commands, such as Save and Print, that apply 
to an entire communications session. You'll find explanations ofthe com
mands on the File menu later in this chapter, in Chapter 3, " Editing, 
Saving, and Printing," and in the " Reference" section. 

The Edit menu contains commands you use to work with text that's part 
of a ftle or a procedure. Chapter 2, " Signing On," Chapter 3, " Editing, 
Saving, and Printing," and the " Reference" section explain how to use 
those commands. 

The Communications menu contains the commands that you use during 
a communications session. You'll find out how to use those commands in 
Chapter 2, " Signing On" and in the " Reference" section. 

The Procedures menu contains the commands you use to create a pro
cedure (a procedure is a script Teleworks Plus follows during a com
munications session). Chapter 4 , " Creating and Using Procedures" ex
plains how to work with procedures. 

The Setup menu contains the commands you use to select the settings you 
need to conduct a communications session. Some of the Setup commands 
are covered in Chapter 2, "Signing On"; the rest are explained in the 
"Reference" section. 

The Binary II menu contains two commands, Pack and Unpack, that let 
you compress documents for transmission and return compressed 
documents to their normal format . Both commands are covered in the 
" Reference" section. 

The Counters 
The time counter works only when you 're engaged in a communications 
session. It starts as soon as you make a connection, and it keeps track of 
the time you're connected to a service or a computer. (Keeping track of 
how long you're connected to a service is important since most services 
charge you by the length of time you ' re connected.) 
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The memory counter keeps track of how much free space is available in 
your computer's memory. Teleworks Plus stores in memory all the infor
mation that appears in the communications area during a session. If you 
run out of space in memory, you can continue with the session, but the in
formation you exchange won't be stored in memory. 

The Communications Area 
The communications area is the part of the screen where information ap
pears when you're in contact with a service or another computer. You can 
also display information from sessions you've saved there. 

The information from a single session is usually more than the com
munications area can display at one time. You can use the scroll bar to 
scroll the information up or down through the communications area so 
you can read all of it. 

To display the scroll bar, move the pointer to the right edge of the com
munications area. To use the scroll bar, you point to the scroll box, hold 
down the mouse button, and move the box in the direction you want the 
document to move; or you point to an arrow and click the mouse button. 

Windows and Boxes 

When you 're using Teleworks Plus, you'll see three different types of 
elements appear in the communications area: windows, dialog boxes, and 
message boxes . 

Windows. Windows are areas you use when you're creating a memo, 
editing text information you've captured, or creating or editing a pro
cedure. Both the procedure and memo windows look the same: 

Close Box ~0 Untitled Title Bar 
I ~ 

Window 

' 

fo 
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You can move a window to a different place on the desktop. You point to 
the title bar, hold down the mouse button, and drag the outline line that 
appears wherever you want the window to be. When you release the 
mouse button, the window is redrawn in the new location. 

The close box lets you remove a window from the communications area. 
To use the close box, you point to it and click the mouse button. 

Dialog boxes. A dialog box appears when Teleworks Plus needs specific 
instructions about a task you've given it before it can carry out the task. 
For example, you use a dialog box to name a procedure you're about to 
have Teleworks Plus save; you also use a dialog box to select the settings 
that will let you send a file to another computer. 

® /Telewor~s. Vl.O / 
Free : 258~ out of 600~ ( Dis~ ) 
D Loader .Q. ( Ne'o' Folder ) 
~ Prodos 
D Startup ( ll()t)ll ) 
OSljstem 
~ T elewor~s.Susl6 

~ 
( t::!:n:;; ) 

Save Rs: ~ Save ] 

ltmmm!l I c Ca ncel ) 

Message boxes. A message box appears when Teleworks Plus has infor
mation about a task it 's carrying out. For example, it might display a 
message to tell you that your modem isn't working properly. 

0 Modem doesn't answer 

The Keyboard 
The keyboard of the Apple IIGS has all the keys that are standard on com
puter keyboards plus a few that are unique to the keyboards of Apple com
puters. The following keys have important functions in Teleworks Plus: 

return 
delete 
esc 

option 
command 

Getting Started 

The option and command keys are unique to Apple computers. Make 
sure you know where they are located. 

The special uses that keys have in Teleworks Plus are explained through
out this guide. If you need information about the usual way that any of the 
keys function , check the " Glossary" at the back of this guide or "The 
Mouse and the Keyboard" in the Apple IIGS owner's guide. 

Setting up Teleworks Plus 
Before you can use Teleworks Plus for the first time, you have to set it up 
to work with your modem. Teleworks Plus is already set up to work with 
most popular modems and interface cards-all you have to do is select the 
modem and card or port you're using. 

That 's simple to do: 

First , select Choose Interface/Modem from the Setup menu. This 
dialog box appears: 

- Card Modem-

• I "I 0 Uni versa! Rpple 0 • Smartmodem 1200 '. 
Prol1odem 1200R Smartmodem 1200 

ProModem 1200R 
Other RS232 (C OK )) 

0 0 ( Cancel ) 

The catalog on the left lists, along with the serial port, the interface cards 
Teleworks Plus is set up to work with. Select either the serial port or the 
name of the card you're using. 

The catalog on the right lists the modems Teleworks Plus is set up to work 
with. Select the name of the modem you're using. If you're using a Hayes
compatible modem, select Hayes. (Ifyour modem isn' t listed see ''Choose 
Interface/Modem" and "Modem" under " Setup Menu" in the 
" Reference" section.) 

Next, clicj.{ the OK button. 

To save those settings permanently, choose Save Setup from the Setup 
menu. This dialog box appears: 
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Save As: 

jar~~ I ) ~ Save 
1:5) /Tel9\IOI~S . V1.0/ 

( ) Open 

D Icons ~ ( Close ) 
0 Loader 

( ) ~Prodos Folder 
0 Stll'tlll ( Drive ) 0System 
~ Telewoth V 1.0 ~ ( Cancel ) 
D Use ot stortl.ll 

First, give the settings you're about to save a name. The name Untitled ap
pears in the space under Save As (Untitled is highlighted to show it 's 
selected). Replace Untitled with a name such as " Modem. Setup" (because 
Untitled is selected, it 's erased as soon as you start typing) . 

At the bottom of the dialog box, there's an empty check box to the left of 
Use at Start-up. Point to the check box and click the mouse button. An X 
appears there. The X tells Teleworks Plus to automatically use the settings 
you're saving unless you give it different settings . 

Finally, click the Save button. Teleworks Plus saves the new settings on 
the program disk, so make sure the write notch on the disk is covered. 

Quitting Teleworks Plus 
If you want to quit Teleworks Plus at any time, first save the information 
that 's in the communications area (see Chapter 3, " Editing, Saving, and 
Printing''), then choose Quit from the File menu. 

14-------------------------------------------

Chapter 2 
__________ Signing On 

This chapter explains how to use Teleworks Plus to communicate with an 
on-line service. You can follow the same basic steps to communicate with 
bulletin boards and other computers. 

Checking Compatibility 
Before you communicate with a service or another computer, you should 
make sure that your modem settings and theirs are compatible. This chapter 
is going to lead you through the steps for signing onto the Activision 
Electronic Support Bulletin Board System. These are the settings for the 
Activision BBS: 

Speed: 300, 1200, or 2400 (Speed is also called baud rate.) 
Format: 8 bits 
Parity: None 
Stop Bits: 1 

To check your modem's compatibility, choose Modem from the Setup 
menu. This dialog box appears: 

Modem Setup 

Speed . 0 300 @ 1200 0 2400 0 9600 
Format 0 SBits 0 6Bits 0 78its @ 88its 

Pori tu . @ None 0 Even 0 Odd 0 Mor~ 0 Space 
Stop Bits : @1 Ots Oz 
Dialing : 0 Pulse @Touch Tone 

Modem Tupe 0 CCITT @Bell 

0 Xon/Xoff flil Xon Chor. [!!] X off Chor. 
0 Reouire Carrier Detect ·' 
l:!:s:l Echo Received Characters 
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If you need to, change the settings that appear in the dialog box to match 
the ones listed above. Make sure the item at the very bottom of the dialog 
box, Echo Received Characters, is checked (Echo Received 
Characters lets the service or computer you're receiving information 
from know that you've received the information it has sent). Also make 
sure that the Dialing setting that's selected is correct for the phone system 
you're using. 

Click OK when the settings are correct . 

Before Dialing 
If you have an auto-dialing modem, there are two things you may need to 
have Teleworks Plus do before it dials the Activision BBS number: dial for 
an outside line and cancel call waiting. You can use the Dialing Prefix 
option on the Setup menu to have Teleworks Plus dial for an outside line 
or cancel call waiting automatically before each call. 

Dialing an Outside Line 

If you have to dial 9 to get an outside line before you make a phone call, 
follow these steps to make 9 a dialing prefix: 

Choose Dialing Prefix from the Setup menu. A dialog box appears. In 
the space that's provided near the bottom of the box, type 9 followed by a 
comma. The comma tells Teleworks Plus to pause for a second before it 
dials the rest of the phone number; the pause gives the phone system time 
to connect your phone with an outside line. Click OK. 

From now on, Teleworks Plus will dial 9 and pause for a second before 
every number you have it dial. 

Disabling Call Waiting 

If you have call waiting, you need to disable it . If you don't disable it and a 
call comes in while you're on-line, the connection you've established will 
be disrupted. Most electronic bulletin boards and on-line information ser
vices automatically end a communications session when there's such a 
disruption. To disable call waiting, you dial *70 before the number you 
want to reach. 
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Here's how to set up • 70 as a dialing prefix: 

Choose Dialing Prefix from the Setup menu. A dialog box appears. In 
the space that's provided near the bottom of the box, type • 70. (If you've 
already set up the system to dial 9 to get an outside line, 9, will appear in 
the dialog box; type • 70 following the comma.) Then click OK. 

Dialing • 70 before you make a call cancels call waiting only for the call 
you're about to make. As soon as you hang up, call waiting goes into effect 
again. 

Dialing a Number 
The Dial a Number option on the Communications menu can dial a 
number for you if you have an auto-dialing modem. You can also use Dial 
a Number to store names and numbers in memory (if you want to save the 
names and numbers you've stored, you use the Save Setup option on the 
Setup menu). 

Choose Dial a Number from the Communications menu. A dialog box 
appears. If you've set up a dialing prefix, notice that it appears in the upper 
right corner of the dialog box. 

If you have an auto-dialing modem and you want to dial a number without 
storing it in memory, you type the number in the space to the right of 
Number to dial, then click OK. If you want to store a number in memory 
before you dial it, you can click the Add button and type the number (and 
a name along with it) in a second dialog box. 

Follow these steps to store the number of the Activision BBS in memory 
(later you'll have Teleworks Plus save it): 

Click the Add button. The second dialog box appears. In the space under 
Name, type Activision BBS. Press the tab key, and in the space under 
Number, type 415-329-7684; if you live in the 415 area, type just 
329-7684. Click OK to return to the first dialog box. 

Activision BBS appears in the catalog on the left side of the dialog box, 
and the number appears in the space to the right of Number to dial. 

To dial the number, click OK. 
·, 
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• If you have an auto-dialing modem, Teleworks Plus dials the number for 
you. 

• If you don't have an auto-dialing modem, dial the number yourself, wait 
until you hear the carrier(a high-pitched tone), then click the OK button 
in the dialog box. 

When you're connected with the Activision BBS, Connection Successful 
appears followed by a welcome message. 

Signing On 
You're now connected with the Activision BBS, but you have to sign on 
before you can actually use the service. "Signing on" means to identify 
yourself to the service, bulletin board, or computer you're connected to. 

The last line on the screen says First Name?, and next to it is a flashing 
cursor. Type your first name, then press return. 

The Activision BBS asks: 

Last Name? 

Type your last name, and press return. 

The Activision BBS asks: 

Calling from (City, State)? 

Type the city and state you're calling from, and press return. 

The Activision BBS displays your name and the city and state you're call
ing from, then asks Is this correct? If the information is correct, type y 
for Yes. Otherwise, type n for No. Then type the information again. 

The Activision BBS next asks you for information about your computer so 
it can send information to you in the proper format . 

The first thing the Activision BBS wants to know is how many characters 
will fit across the screen in a single line. Type 80 next to Terminal Width 
(10-132)?, and press return. 

The Activision BBS displays a list of terminals and asks you to type the let
ter that matches the terminal you're using. 
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The Activision BBS displays the settings it uses for Apple IIGS: 

Upper/Lower Case 
Line Feeds Needed 
00 Nulls after each <CR> 

It then asks if you want to modify those settings. Type n . 

The Activision BBS asks if you want it to pause after each full screen of 
text. If you answer No, text will scroll up the screen as fast as Teleworks 
Plus can display it; if you answer Yes, the Activision BBS will send 
Teleworks Plus only a single screenful of text at a time. Type y or n. 

The Activision BBS asks how many lines there are on each page-that is, 
how many lines of text will fit on the screen. Type 18, and press return. 

The Activision BBS next asks you to create a password for yourself. A 
password serves two functions: it distinguishes you from anyone else us
ing the bulletin board who might have the same name as you, and it 
prevents anyone else from pretending to be you when they sign on the 
system (for example, it prevents someone from ordering a product from 
Activision and charging it to you). 

Your password can be up to eight letters long and it can be made up of let
ters, numbers, symbols, punctuation marks, or spaces. Upper- and lower
case letters make a difference-for example, if you type your password as 
Sesame now, the Activision BBS won't accept sesame or SESAME when it 
asks you for your password in the future. 

Type a password and press return. Write down the password you've 
chosen in case you forget it, and put it in a safe place. 

You are now " signed on" to the Activision BBS. (In the future, the process 
is much simpler: you need only to type your name and your password.) 

The Activision BBS displays information about which messages you've 
read, how long you can stay connected, whether you have any messages 
waiting for you, and so on. Then it displays the main menu. 

' 
Browse through some of the options that appear on the menu to see what 
the Activision BBS has to offer (remember that the clock just above the 
communications area keeps track of how long you've been on-line). 

Signing Off 
When you're ready to sign off, type g (to choose Good-bye). A log off 
menu appears; type g again to end the session. 
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The Activision BBS displays another menu. If you select Activision, the 
BBS displays the Product Support Area, which contains a specific section 
of information about Teleworks Plus. 

The sysop, or system operator, is the person who manages the bulletin 
board. If you have any questions about how the bulletin board works or 
any suggestions that might make it work better, you can leave a message 
for the sysop. You'll receive a reply by way of electronic mail. If you want 
to leave a message for the sysop, choose p from the BBS main menu to go 
to the Post Office (E-mail). Choose I to leave a message; address it to the 
sysop. You can also leave a message for the sysop in the Teleworks section 
of the Product Support Area. Otherwise, type g to end the session. 

The Activision BBS displays the time you logged on (connected with the 
system) and the time you logged off(ended the session). It also asks you to 
hang up. If you have an auto-dialing modem, it will probably hang up 
automatically. 

Hanging Up 
If your modem doesn't hang up automatically after a communications ses
sion, you can use the Hang Up option on the Communications menu. 
Hang Up not only breaks the telephone connection, it also tells Teleworks 
Plus that the session is over. 

To use Hang Up, just choose it from the Communications menu. 
Teleworks Plus immediately breaks the telephone connection and stops 
the clock that's above the communications area. Be sure to put the 
telephone handset back in its cradle if you've taken it off hook. 

Saving the Current Setup 
Before you go on, save the Activision BBS phone number, the dialing 
prefix (if you entered one), and the modem settings you chose. To do so, 
choose Save Setup from the Setup menu, name the current settings 
Activision BBS, then click the Save button. 

The next chapter explains how to save the information you've received 
from the Activision BBS. If you don't have time to continue with Chapter 3 
right now, save the information that appeared on the screen in the session 
you just ended so that you can use it when you get around to Chapter 3. 

Here's how: 

Choose Save As from the File menu. A dialog box appears. In the space 
under Save as, at the bottom of the box, type Activision.Tour. Click Save. 
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Chapter 3 

---Editing, Saving, and Printing 

This chapter explains how to extract useful information from a communica
tions session, and how to save and print the information. 

Reviewing a Session 
Teleworks Plus automatically stores in memory the information that is ex
changed in a communications session. (If you run out of space in memory 
during a session, you can continue with the session, but the information 
you exchange won't be stored in memory.) You can review the session 
with the Activision BBS by doing this: 

First, move the pointer to the right edge of the communications area to 
display the scroll bar. Then scroll through the text of the entire session 
either by clicking the scroll arrows or by dragging the scroll box up and 
down the scroll bar. 

Editing the Text in Memory 
After reviewing a session, you may find that you want to save some or 
most of the information you received during the session. To edit the infor
mation in memory-deleting text you don't want to keep and perhaps 
rearranging what you do want to keep-you use the Edit Memo function. 

Choose Edit Memo from the Edit menu. An editing window appears. The 
window lets you scroll through the very same text that you scrolled 
through in the communications area. But the window also lets you make 
any changes you want to the text there. 

Erasing Text 
There are three ways to erase text: you can use the delete key and erase 
text character by character; you can select a block of text, then press 
delete to erase it all at once; or you can select a block of text, then use the 
Cut or Clear function. 

Erase everything above the line where First Name? appears: 

First, position the insertion point to the left of First. You do that by plac
ing the pointer just to the left of First and then clicking the mouse button. 
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Next, press delete. When you do, the blank line above First Name? is 
erased, and the line that First Name? is on moves up. 

If you erase something by mistake, you can use Undo to restore it to the 
window. Choose Undo from the Edit menu and watch what happens. 
(Undo also reverses the effects of Cut, Paste, and Clear.) 

Press delete again. Once again, the blank line above First Name? is eras
ed, and the line First Name? is on moves up. If you keep pressing delete 
over and over, you'll eventually get the job done. But there's a quicker 
way to erase everything above First Name?: that's to select everything 
above First Name?, then press delete just once. 

Here's what to do: 

Place the pointer in the upper left corner of the window, hold down the 
mouse button, and drag the mouse down until everything above First 
Name? is highlighted. Then press delete. The entire highlighted area is 
deleted. 

The difference between selecting a block of text and pressing delete and 
selecting a block of text and using Cut is that when you use Cut, you can 
use the text you cut over again. 

Try this: 

Select the line First Name? is on. Then choose Cut from the Edit menu. 
The line disappears just as the text above it did when you pressed delete. 
Now place the insertion point to the left of Calling from on the line 
below Last Name?, and choose Paste from the Edit menu. First Name? 
reappears there. 

When you use Cut, the text you've cut is placed on the Clipboard, where 
it stays until you cut something else. 

Copying Text 
Copy, which is also on the Edit menu, works much the same way as Cut: 
whatever you copy is placed on the Clipboard. The difference between 
the two is that text you copy isn' t removed from the window as it is when 
you use Cut. 

Pasting Text 
You can use Paste, which is also on the Edit menu, to insert whatever is 
on the Clipboard back into the text in the window. 

22----------------------------------------------

Editing, Saving and Printing 

You can use Cut and Paste together to move text from one part of the 
window to another. To remove it from its original location, you select it 
and then cut it . Then you move the insertion point to the place where you 
want to move the text and choose Paste to insert it there. 

Even after you paste a copy of text on the Clipboard into the text in the 
window, the text remains on the Clipboard until you cut or copy a dif
ferent section of text. That allows you to insert the same text into as many 
places as you want in the window. 

Use delete, Cut, Copy, and Paste to trim down the text in the window 
until just the main menu appears-you can use it as a reference for future 
sessions. 

Saving Information 
To save the information that's in memory-whether you've edited it or 
not-you use the Save function. 

Choose Save from the File menu. A dialog box appears. In the space 
under Save as, at the bottom of the box, you type the name you want to 
give to the information you're saving. For the information you're saving 
from your session on the Activision BBS, type Activision.Tour. 

Before you save the information, eject the Teleworks Plus program disk 
from the drive, and insert a initialized data disk. Click the Disk button. 

Notice the Cancel button in the lower right corner of the dialog box. You 
can't use Undo to " unsave" information once Teleworks PIUs has started 
to save it (in fact , you can't undo any of the commands on the File menu 
once Teleworks Plus has started to carry out the command). Instead, you 
use the Cancel button to leave the dialog box without carrying out the 
Save command. 

Click Save to save the information. Once you've saved the information, 
it 's called a file or a document. 

The Save dialog box appears onl}; the first time you save a document. If 
you change the document and want to save it again, Save assumes you 
want to replace the old version with the new version. If you want to save 
different versions of a document , use Save As and give each version a dif
ferent name. 
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Printing Information 
You can print the information that's in memory only if the editing window 
is in the communications area. Before you can print anything for the first 
time, you have to let Teleworks Plus know what type of printer you have 
connected to your computer and which port the printer is connected to. 

Note: If you're using AppleT~ see "Choose Printer" in the "Reference" 
section for important information. 

Select Choose Printer from the File menu. A dialog box appears. If the 
printer type and printer port selected in the box match your system, click 
OK. If not, point to the correct printer and port and click the mouse but
ton. When you've selected the printer and port you want, click OK. 
Teleworks Plus saves the selections you've made on the program disk. 

To print the information in the editing window, first make sure that your 
printer is connected to the computer, and that it's turned on and on-line. 
Then choose Print text from the File menu. Leave all the options displayed 
in the dialog box set as they are. Click OK. The information you've saved 
from your tour of the Activision Electronic Bulletin Board System is 
printed. 

Printing During a Session 

You can print information just as you receive it during a communications 
session. 

Pull down the Edit menu and you'll notice that Edit Memo has been 
replaced on the menu by Stop Editing Memo. Choose Stop Editing 
Memo to close the editing window. (Notice that the changes you've made 
in the editing window are reflected in the communications area.) 

Pull down the File menu and you'll see that Print text has been replaced 
by Continuous Printing. If you select Continuous Printing during a 
communications session, all of the information that appears in the com
munications area will also be printed. 

Note: Continuous Printing will not work if your printer is on a network. 
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Chapter 4 
__ Creating and Using Procedures 

You'll fmd that there are certain things that you do almost every time you're 
in a communications session-for example, dialing a service and signing on 
with your ID and password. You can create procedures that Teleworks Plus 
can use to carry out such actions automatically. 

A procedure is like a script. It consists of a series of actions you want 
Teleworks Plus to carry out. An action can be a command (such as Dial a 
Number or Clear Screen), or it can involve typing text in response to a 
prompt. The only difference in the way you and Teleworks Plus perform 
the actions is that Teleworks Plus can carry them out faster than you can. 

There are two different ways of creating a procedure. One is to write the 
actions down one by one. The other is to have Teleworks Plus record the 
actions as you actually carry them out in a communications session. 

Recording a Procedure 
To record a procedure, you choose Record a Procedure from the Pro
cedures menu when you're at the point where you want Teleworks Plus to 
start monitoring each action you take (Stop Recording replaces Record a 
Procedure on the menu). 

Teleworks Plus records the commands you use and the text you type until 
you choose Stop Recording. 

Follow these steps to record the procedure you use to sign on to the 
Activision BBS: 

First, choose Record a Procedure from the Procedures menu. 

Next, choose Dial a Number from the Communications menu. When 
the dialog box appears, select Activision, then click OK. 

• If you have an auto-dialing modem, Teleworks Plus dials the number for 
you. 

• If you don't have an auto-dialing modem, dial the number yourself, wait 
until you hear the carrier (a high-pitched tone), then click the OK button 
in the dialog box. 
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When you're connected to the Activision BBS, Connection Successful 
appears in the dialog box. The bulletin board welcome message appears, 
and then the Activision BBS prompts you to enter your first name. The next 
section explains how to record information in response to a prompt. 

Waiting for a Prompt 
Most of the text you type when you're communicating with a service is in 
respo!lSe to prompts. The service always expects you to type a certain kind 
of information after a prompt. It's important when Teleworks Plus is 
following a procedure that it keep in step with the prompts that appear, or 
its actions won't make sense to the service it's communicating with. 

You can make sure Teleworks Plus keeps in step with the prompts by using 
the Wait for Characters option. Wait for Characters keeps Teleworks 
Plus from proceeding with the next step in the script until it receives the ap
propriate prompt from the service. 

The prompt First Name? is now in the communications area. To make sure 
that Teleworks Plus doesn't type your first name before the Activision BBS is 
ready for it, you should use the Wait for Characters option (which 
Teleworks Plus will record) before you t}"pe your first name. 

Here's what to do: 

Choose Wait for Characters from the Procedures menu. A dialog box 
appears. Notice that the last three characters of the prompt, arne?, already 
appear in the space to the right of Wait for Characters. (Only the last four 
characters of a prompt appear because that's usually enough to distinguish it 
from the text that comes before it.) Click OK, and Teleworks Plus adds the 
instruction to wait for arne? to the procedure it's recording. (For more in
formation about other options in the dialog box, see "Wait for Characters" 
in the "Reference" section.) 

Type your first name the same way you entered it when you first signed on 
to the bulletin board in Chapter 2, then press return. 

The Activision BBS asks you for your last name. Choose Wait for 
Characters again, click OK, then type your last name, and press return. 

The bulletin board responds with the name of the city and state you're 
calling from and asks if it's correct. Choose Wait for Characters, click 
OK, then type y. 
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(If the name of the wrong city or state appears, it means one of two things: 
either someone who has the same name as you and lives somewhere else 
has used the Activision BBS, or you've typed your name wrong. Choose 
Stop Recording from the Procedures menu. Type n until the bulletin 
board responds with the correct city and state. If the correct city and state 
don't appear, choose Hang Up from the Communications menu and 
start over.) 

Finally, the Activision BBS prompts you to type your password. 

To record your password, first choose Wait for Characters to record the 
password prompt, then click OK. Type your password just as you 
originally entered it. Teleworks Plus displays only asterisks (*) on the 
screen so that no one can find out your password by seeing it on the 
screen. Press return. 

Recording your password makes signing on much easier, but it also means 
that anyone can sign on to the Activision BBS with your name by just run
ning the procedure you're recording. If you'd rather not keep a procedure 
file that has your password in it, you can delete the file you're creating at 
the end of this chapter. 

After you've entered your password, the Activision BBS displays some in
troductory information, and then the main menu. 

Record the following selections from the bulletin board's menus. The pro
cedure will then automatically take you to the Post Office, where you can 
leave a message for another user. 

Choose Wait for Characters to record the command prompt that 
follows the main menu; then click OK. Type p to choose Post Office 
(E-Mail). 

When the Post Office menu appears, choose Wait for Characters to 
record the command that follow the menu, then click OK. Type s to 
choose Send E-Mail. 

A prompt appears that asks Who is the message to? 

Choose Stop Recording from ' the Procedures menu to end the 
procedure. 

A dialog b9x appears. It works just like the box you used in the last chapter 
to save the information from your first Activision BBS session. Replace 
Untitled with Bbs.Signon, and click Save. Teleworks Plus saves the 
procedure. 
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You can continue using the Activision BBS if you want to, or you can type 
g to sign off. Remember to select Hang Up from the Communications 
menu (if you need to) after you sign off. 

Editing a Procedure 
Once you've recorded a procedure, you can review it and edit it just like 
any other information ftle . You'll remember that to display the informa
tion in memory in an editing window, you chose Edit Memo from the 
Edit menu. To display a procedure in an editing window, you choose Edit 
a Procedure from the Procedures menu. 

To take a look at Bbs.Signon, choose Edit a Procedure. A dialog box ap
pears. Select Bbs.Signon, then click Open. An editing window appears 
with the Activision BBS sign-on procedure in it . 

You edit a procedure the same way you edit information from a session. 
Suppose you decide after you use the Activision BBS a few times that in
stead of automatically going to the Post Office, you always want to see if 
any other users are in conference before you do anything else. Instead of 
rerecording the entire procedure, you only need to change a few steps. 

Here's what to do: 

Find the place near the end of the procedure where p appears. It 's the 
command that chooses Post Office (E-Mail). 

Select p and type c. The letter c chooses Conference Hall #1. When you 
choose the Conference option, the Activision BBS displays a message tell
ing you which conference you've joined and how many other callers are 
currently in the conference. 

The final two commands, <Wait "and:"> and <<s>> are now un
necessary. Select them and press delete. 

Click the close box at the left end of the title bar. Before the editing win
dow closes, a dialog box appears that asks if you want to save the 
modifications you've made. Click Yes. The procedure is saved again, this 
time with the two conference commands included. 

The next time you use the procedure you've created to sign on to the 
Activision BBS, Teleworks Plus will automatically instruct the bulletin 
board to display the names of the users in conference. 
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Writing a Procedure 
You can also create a procedure by actually writing the script action by ac
tion. Writing a procedure is more difficult than recording one because you 
have to be careful to use the correct procedure commands, punctuation, 
and syntax. 

Procedure Commands 

A procedure command is a word that does the same thing in a procedure 
that you do when you choose a command from a menu. 

Choose Edit a Procedure and open Bbs.Signon again so you can take a 
look at the commands it contains. 

Notice that the Dial a Number command from the Communications 
menu is represented in the procedure by the single word Dial. Wait for 
Characters is represented by Wait. Every command that you can choose 
from a menu or dialog box has a procedure command that carries out the 
same action. All the procedure commands are listed in Appendix A, 
" Procedure Commands." 

Punctuation 

Punctuation is just as important in a procedure as it is in a sentence. Punc
tuation tells Teleworks Plus how to treat the text it sets off. 

For example, you'll notice that each command and the information the 
command uses are surrounded by angle brackets(<>). The angle brackets 
tell Teleworks Plus that it 's to treat the text they set off as a command. 
You'll also notice that the information a command uses-for example, the 
phone number following Dial-is set off by quotation marks. The quota
tion marks make it clear to Teleworks Plus which characters are the com
mand itself and which are the information the command uses. 

Two left angle brackets ( << ) tell Teleworks Plus to type all the text that 
follows until it comes to two right angle brackets ( >> ). 

Syntax 

Syntax is 'the order that commands, punctuation, and text appear in. The 
order in which you arrange things lets Teleworks Plus make sense of the 
various elements you're using. 
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For example, text you want Teleworks Plus to type comes after two left 
angle brackets, not before them. The information a command uses comes 
after, not before, the command. 

Appendix A, "Procedure Commands," which lists the procedure com
mands, also tells you what the correct syntax is and how to use punctua
tion correctly. 

Before you go on, click the close box at the left end of the editing 
window's title bar to close the window Bbs.Signon is in. 

Creating a Sign-off Procedure 
The steps below lead you through the process of creating a sign-off pro
cedure for the Activision BBS. 

First, choose Write a Procedure from the Procedures menu. An empty 
editing window appears. 

You'll remember that the first thing you do to start the sign-off procedure 
is to type gat a command prompt. You don't want to start the procedure 
you're writing with an instruction to wait for the command prompt because 
you won't run the procedure until the command prompt has already 
appeared. Instead, begin by typing two left angle brackets: 

<< 

The two left angle brackets tell Teleworks Plus to type whatever text 
follows until it comes across two right angle brackets ( >> ). 

Type 2 (to choose Good-bye), then two right angle brackets. The text in 
the editing window should look like this: 

<<2>> 

The Activision BBS responds to the Good-bye command with a message 
telling you you're about to log off (leave the bulletin board). It displays the 
log-off menu. To have Teleworks Plus wait for the command prompt, type: 

<Wait "and:"> 

The left angle bracket at the beginning of the line tells Teleworks Plus that 
the text that follows is a command. Wait, like the Wait for Characters 
option on the Procedures menu, tells Teleworks Plus to wait until the 
text between the quotation marks appears before it continues. In this case, 
the text between the quotation marks, and:, is the last four letters of Com
mand:, the text of the prompt. 
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Under normal circumstances you'll type L to choose LOGOFF. 
(Remember that you don't have to use the procedure you're creating to 
sign off; if you want to leave a message for the sysop before you sign off, 
you can type the sign-off commands yourself.) 

To choose LOGOFF, type l. 

The Activision BBS then responds with a message that looks something 
like this: 

Logged on at 13:47:41 
Logged off at 13:59:02 

Thanks for calling, call back soon! 
Please Hang Up Now 

If you have an auto-dialing modem, you don't need to add anything else to 
the procedure-your modem will hang up for you automatically. But if 
you don't have an auto-dialing, you want Teleworks Plus to wait for the 
final line of the bulletin board's good-bye message-Please Hang Up 
Now-before it does anything else. Type: 

<Wait" Now"> 

Be sure to include the space that precedes Now. 

When Please Hang Up Now appears, you can have Teleworks Plus choose 
Hang Up from the Communications menu. In the script type: 

<Hang Up> 

The script for the sign-off procedure is complete. The text in the window 
should look like this: 

<<2>> 
Wait "and:" 

<<I>> 
<Wait" Now"> 
<Hang Up> 

·, 
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To save the procedure, click the close box. As before, a dialog box appears 
that asks if you want to save the modifications you've made. Click Yes. A 
second dialog box appears. It works just like the box you used earlier to 
save Bbs.Signon. Replace Untitled with Bbs.Signoff, and click Save. 
Teleworks Plus saves the procedure. 

Running a Procedure 
When you want to use a procedure you've saved, you choose Run a Pro
cedure from the Procedures menu (Stop a Procedure replaces Run a 
Procedure on the menu). The Open dialog box appears to let you select 
the procedure you want to run. You select it, then click Open. The pro
cedure begins running. You can stop it whenever you want by choosing 
Stop a Procedure. 

You can also have Teleworks Plus run a procedure automatically as soon as 
you start the program. See "Start-up Procedure" under "Procedures" in 
the "Reference" section for information. 
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Chapter 5 
____ Sending and Receiving Files 

Most bulletin boards and on-line information services let you post brief 
public notes and send longer private messages to other subscribers. Most 
bulletin boards and information services also let you send (or upload) and 
receive (or download) files of just about any length. Any kind of file that 
you can create using Apple IIGS software, you can send or receive with 
Teleworks Plus-for example, a Writer's Choice elite document, a List 
Plus list , a Draw Plus graphic, or a Paintworks Gold picture. This chapter 
explains how to send and receive the simplest kind-text files . 

If you quit Teleworks Plus at the end of the last chapter, start it again. 

Receiving Files 
The steps you follow to receive a file depend a great deal on the bulletin 
board or information service you 're receiving the file from. But no matter 
how different the overall process may be, every procedure for down
loading files has these same basic steps: 

• Set up the protocol for exchanging the file . 

• Select the file you want to receive. 

• Start the transfer. 

• Save the file when the transfer is complete. 

Setting Up the Protocol 

A telecommunications protocol is a set of rules that the computers at both 
ends of a connection follow to make sure that the file that's received is the 
same as the file that was sent. A protocol contains, among other things, 
ways to check for errors that have been introduced into a file during its 
transmission. There are many different protocols; some are designed spec
ifically for text, others for graphics, still others for binary files , and so on. 

·, 
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To select a protocol for either sending or receiving files, you choose 
Transfer a File from the Setup menu. This dialog box appears: 

File Transfer Setup · 

Protocol : @ ASCII 0 XModem ( Teleworks) 0 XModem 0 None 

ASCII Transfer . 

Oelou Between Characters (ms) . [!] 
After CR (II lOs) . W 
D Woi t for prompt ot beginning of line 0 
D Force CR ofter ~ Characters 1:81 No WordCut 

D Woi t for Echoed Characters 

1:81 Beep when finished 

To set up a protocol, you click the button next to the protocol you want to 
use. If you select the ASCII transfer, you also have to fill in the other infor
mation in the box. Then you click OK to record the selection you've made. 

In a later section of this chapter, you're going to download a file from the 
Activision BBS. Before you sign on, set up the protocol you'll use, then: 

First, choose Transfer a File from the Setup menu. The File Transfer 
Setup dialog box appears. Click the button next to XModem (the other 
protocols are described in the "Reference" section under "Transfer a 
File"). Once you've chosen the XModem protocol, you don't need to 
select any other setting in the box. Click OK. The dialog box disappears. 

Run Bbs.Signon(the sign-on procedure you created in the last chapter) to 
sign on to the Activision BBS. When the main menu appears, type a to 
choose Activision. The Activision main menu appears. 

Type p to choose Product Support. The Activision Product Support 
menu appears. 

Type T to choose Teleworks Plus. The Teleworks Plus main menu appears. 

Selecting a File 
The Teleworks Plus main menu has two options you' re going to use in this 
chapter: Download a File and Upload a File. To display a list of the files 
you can download, typed at the command prompt. 
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Let the bulletin board scroll through the list until TELEWRKS.TXT ap
pears, then type S to stop the listing. A prompt appears where you can 
type a selection (as well as display the list again, set a protocol, or exit). 

TELEWRKS.TXT is a special file that's on the Activision BBS just so you 
can use it to learn how to use Teleworks Plus to download files. To select 
it, type telewrks.txt at the prompt, then press return. 

The bulletin board then displays a list of the protocols that are available 
for downloading the file. Type 4 to select the XMODEM protocol. 

The bulletin board next displays the number of records the file you've 
selected contains and the amount of time it will take to transmit the file. It 
displays another prompt to tell you that it's waiting for you to start the 
transfer. 

Starting the Transfer 

To start the transfer, choose Receive a File from the File menu. This 
dialog box appears: 

'OK' to stort transfer 

When you're ready to start, click OK. 

As the Activision BBS transmits the file, Teleworks Plus displays the number 
of blocks that it has received. (Teleworks Plus means the same thing by 
" blocks" that the Activision BBS means by "records.") When the entire 
file has been transmitted, Teleworks Plus displays Transfer Successful in 
the dialog box. 

Press any key to continue. 

Saving .,the File 
Teleworks Plus displays the Save dialog box so that you can save the ftle 
you've just received. 
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In the space below Save as, type DownloadTest, then click the Save 
button. Teleworks Plus saves the file on the disk. 

The process of downloading a file from a bulletin board or an information 
service is that simple. While the exact steps will vary depending on the 
system you're downloading from, the four steps you've just completed 
are always the essential part of the process. 

Sending a File 
The process of sending a file is not that different from receiving a file-just 
as the process of opening a file isn't that different from saving one. 

This section leads you through the process of sending back to the Activision 
BBS the file you've just received from it. The steps for sending a file-like 
the steps for receiving a file-depend a great deal on the bulletin board or 
information service you're sending the file to. But every procedure for 
uploading files has these same basic steps: 

• Set up the protocol for exchanging the file . 

• Select the file you want to send. 

• Start the transfer. 

Go to the Teleworks Plus main menu, and type u to select Upload a File. 

The bulletin board asks you to enter a name. The name you type doesn't 
have to be the same as the file's current name because it 's the name the 
bulletin board is going to use for the copy of the file you send it . The name 
can be from 1 to 8 characters, followed by a period and a 3 letter extent ion 
(for example, Telewrks.txt). 

For the file you're going to send, type the first eight letters of your name, a 
period and twp (for example, patwilli. twp), and press return. If a 
message appears that says the file already exists, it means that someone 
with a name similar to yours has already uploaded the file; try a different 
form of your name. 

The next prompt asks for a description of the file you're uploading. You 
can use up to 40 characters for the description. 

The next prompt asks you to choose a protocol for the transfer. 
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Setting Up a Protocol 
Setting up a protocol for sending a file is exactly the same as setting up a 
protocol to receive a file . In fact, since you're sending a file back to the 
same system you received it from, you don't need to make any change to 
the protocol setting. 

Since you're using XModem again, type 4 to choose XMODEM Protocol 
Checksum. (Checksum is a way of checking for errors by making sure the 
file that 's received contains exactly the same amount of information as the 
file that was sent.) 

Starting the Transfer 
To start the transfer, choose Send File from the File menu. A dialog box 
that 's identical to the Open dialog box appears. Select DownloadTest 
from the list, then click the Open button. 

A second dialog box appears that tells you that Teleworks Plus is ready to 
send DownloadTest. Click OK to start the transfer. 

Teleworks Plus displays the number of blocks it has sent as it transmits 
them. When it has transferred the entire file, it displays Transfer Suc
cessful. 

Press any key to remove the dialog box from the communications area and 
end the uploading process. 

You can continue working with the Activision BBS (you may want to 
download some of the other files that are available), or you can sign off. 

·, 
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Apple 

About Teleworks Plus 
About Teleworks Plus gives you information about the version of 
Teleworks Plus you're using and the name of the document that's current
ly open on the desktop . 

To use About Teleworks Plus: 

• Choose About Teleworks Plus from the Apple menu. 

A message box with information about Teleworks Plus appears. 

• To go back to the desktop, click OK. 

Dml. 
Ope\1:.. o o 
Sove os 
Sove Rs ... 
Choose printer ... 
Poge SetUp ... 
Continuous Printing oP 
Send rile 
Receive file ... 
Quit oa 

File 
Occasionally, when you choose a selection from the File menu, a dialog 
box appe~rs that asks if you want to save the changes you've made to the 
document on the screen since you last saved it. The dialog box gives you a 
chance to save those changes. 
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The three buttons in the box give you these choices: 
Yes. Click Yes, and a dialog box appears that lets you save the docu
ment. Name the document if you need to, then click Save. Once you've 
saved the document, the command you've selected is carried out. 

No. Click No, and the command you've selected is carried out im
mediately. The document on the screen isn't saved and you can't get it 
back. 

Cancel. Click Cancel if you decide you don't want the command 
you've selected to be carried out. 

Open 
Use Open to redisplay a document you've saved on a disk. 

To use Open: 

• Choose Open from the File menu, or hold down command and type 
0 . 

A dialog box appears. 

• Click the name of the document you want to open. 

The buttons on the box give you these choices: 

Disk. If the document you want to open is on a disk other than the one in 
the drive, put the new disk in the drive and then choose Disk to display 
the names of the documents (and other files) on the new disk. 

Open. Click Open to have the document you've selected displayed on the 
desktop. 

Close. Click Close if there's a folder open and you want to close it. If 
there's no folder open, Close is dimmed. 

Cancel. Click Cancel if you decide not to open a file. 

Save 
Use Save to make a permanent copy of a document on a disk. If there's 
already a document (or any other file) on the disk that has the same name 
as the document you want to save, the document you're saving erases it 
and replaces it. 
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You can also use Save to create a folder to save documents in. Saving 
documents in a folder is an easy way to keep documents that are related 
together. 

To use Save: 

• Choose Save from the File menu, or hold down command and typeS. 

If you've saved the document before, Teleworks Plus saves it again im
mediately. 

If you're saving a document for the first time, a dialog box appears. 

• Type a name for the document in the space under Save As. 

The buttons in the box give you these choices: 

Disk. If you want to save the document on a disk other than the one in the 
drive, replace the disk in the drive with the new disk. Click Disk to 
display the names of the documents on the new disk. 

New Folder. To create a new folder, type a name for it in the space under 
Save As, then click New Folder. Use Open to open the new folder 
whenever you want to save another document in it. 

Open. If you want to save a document in a folder, select the folder from 
the catalog and click Open. 

Close. You can use Close only if a folder is open. Click Close to close the 
folder. 

Save. Click Save when you're ready to save the document. 

If a dialog box appears that says Volume full, there isn' t enough room on 
the disk to save the document. Click OK, then eject the disk from the 
drive and replace it with an initialized disk that has space on it. 

Cancel. Click Cancel if you decide not to save the document. 

Save As 

Use Save As to save different versions of the same document. You first 
give a new name to a document you've already saved, and then save the 
document under the new name. 

·, 
As long as you give the new version a different name, Save As, unlike the 
Save command, doesn't replace the old document with the new one. 
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You can't undo Save As once it has been carried out. 

To use Save As: 

• Choose Save As from the File menu. 

A dialog box appears that's just like the one that accompanies the Save 
command. The functions of the buttons that are available are explained 
above. 

Choose Printer 
Use Choose Printer to let Teleworks Plus know what type of printer you 
have connected to your computer and which port the printer is connected 
to. 

If you're using AppleTalk, see ' 'Using AppleTalk'' later in this section, then 
follow the instructions below. 

To use Choose Printer: 

• Make sure that the Teleworks Plus application disk is in the drive that's 
active. 

• Select Choose Printer from the File menu. 

A dialog box appears. 

• Select one of the printers from the printer type catalog. Use the arrows 
to scroll the list up or down if you need to. 

• Select one of the ports from the printer port catalog. 

The buttons in the box give you these choices: 

OK. Click OK when you've selected your printer and the port it 's con
nected to. 

Cancel. Click Cancel to return any settings you've changed to the way 
they were originally and to return to the desktop. 

Using AppleTalk. If you want to choose AppleTalk as the printer port: 

• Go to the Control Panel. To do so, first hold down control and com
mand, then press esc. 

The Desk Accessories window appears. 

• Select Control Panel, then press return. 
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The Control Panel menu appears. 

• Use the arrow keys to highlight Slots, then press return. 

A list appears that shows the settings of your computer's slots. 

• Use the up and down arrows keys to highlight Slot 1, then use the right 
arrow key to display Your Card next to it. 

Note: Make sure Slot 1 is not set to Printer Port, or your computer 
will stop working when you try to use AppleTalk. 

• Use the arrow keys to highlight Slot 7 and set it to Built-in AppleTalk. 

• Press return to save the slot settings and to return to the Control Panel 
menu. 

• Select Quit to return to the Desk Accessories menu. 

• Select Quit on the Desk Accessories menu to go back to Teleworks Plus. 

• If you want to save a copy of the document on the screen, save it. 

• Quit Teleworks Plus, and turn the computer off. 

The changes you made to the settings of the slots on the Control Panel 
won't take effect until you start the computer again. 

• Turn on the computer again and restart Teleworks Plus. 

• Follow the instructions for using Choose Printer above, and choose 
AppleTalk from the printer port catalog. 

When you're finished using AppleTalk, go to the Control Panel and change 
the settings of the slots back to the way they were. Then turn the com
puter off, turn it back on, and restart Teleworks Plus. 

Page SetUp 

Use Page SetUp to indicate how your printer is to print a document. 
Page SetUp determines how a document appears on a page: you can, for 
example, print a document on its side (with the lines of text parallel to the 
long edge of the paper rather than the short edge), or you can print text at 
half its usual size. 

The settings you choose are saved when you save the document. 
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To use Page SetUp: 

• Choose Page SetUp from the File menu. 

A dialog box appears. The settings you can choose from differ depending 
on the type of printer you selected in the Choose Printer dialog box. 

Image Writer. If you chose Image Writer in the Choose Printer dialog box, 
the Page SetUp dialog box gives you these settings to choose from: 

Paper: 

US Letter. For 8 112 by 11 inch paper. 

US Legal. For 8 112 by 14 inch paper. 

A4 Letter. For 8 114 by 11 2/3 inch paper. 

International Fanfold. For 8 114 by 12 inch paper. 

Vertical Sizing: 

Normal. The printed text looks just like it does on the screen-the page 
is printed with the same number of rows of dots as the text on the screen 
is displayed in. 

Condensed. The text is printed half the height of the text on the screen, 
but with the same number of dots as normal text. 

Printer Effects: 

50% Reduction. The list is printed half its normal size. 

No Gaps Between Pages. The list is printed continuously, without page 
breaks. 

Orientation: 

Tall. The text is printed upright on the page, with the top line at the top 
of the page. 

Wide. The text is printed sideways on the page, with the top line down 
the right side of the page. 

Laser Writer. If you chose Laser Writer in the Choose Printer dialog box, 
the Page SetUp dialog box gives you settings like the ones for the Image
Writer, with these differences: 
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Vertical Sizing: 

Normal. The printed text looks just like it does on the screen (the page 
is printed with the same number of rows of dots as the text on the 
screen is displayed in). 

Intermediate. The letters in the printed text look two-thirds as high as 
the text on the screen (the page is printed with one and a half times the 
number of rows of dots as the text on the screen is displayed in). Select 
this option to fit a full page of text on paper that's being printed in the 
Wide rather than the Tall orientation. 

Condensed. The text is the same height as it appears on the screen, but 
it's printed with twice as many rows of dots as the text on the screen is 
displayed in. The result is a high resolution printed copy that resembles 
what a Macintosh would produce. 

Printer Effects: 

Smoothing: The printer adds extra dots in between points that form a 
line to produce a higher-resolution copy. 

Font Substitution. When you use certain fonts , a LaserWriter 
substitutes different fonts for the ones you've used when it prints the 
document. Teleworks Plus uses a font named Shaston. A LaserWriter 
substitutes Helvetica for Shaston automatically whether or not you've 
selected this option. 

Reduce or Enlarge. To reduce or enlarge the text of the document, 
type the percentage you want the text reduced or enlarged in the space 
next to Reduce or Enlarge?. 

You can type a number from 25% to 400% (50% reduces the text to 
half its normal size; 200% enlarges the text to twice its normal size.) 

The buttons in the box give you these choices: 

OK. Click OK to record the settings you've chosen. 

Cancel. Click Cancel to return any settings you've changed to the way 
they were originally and to return to the desktop. 

•, 
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Continuous Printing 

Continuous Printing appears on the File menu unless you're creating or 
editing a procedure. If you're creating or editing a procedure, Print text, 
which is explained below, appears. 

Use Continuous Printing to print text as you receive it. 

To use Continuous Printing: 

Select Continuous Printing from the File menu, or hold down com
mand and type P. 

Note: Continuous Printing will not work if your printer is on a network. 

Print Text 

Print text appears on the File menu when you're creating or editing a 
procedure. Otherwise, Continuous Printing, which is explained above, 
appears. 

Use Print text to print the document on desktop. To stop printing once it 
has started, hold down command and type a period. 

To use Print text: 

• Choose Print text from the File menu, or hold down command and 
type P. 

A dialog box appears. The settings you can choose from differ depending 
on the type of printer you selected in the Choose Printer dialog box. 

ImageWriter. If you chose ImageWriter in the Choose Printer dialog 
box, the Print dialog box gives you these settings to choose from: 

Quality: 

Better Text. Produces the highest quality printed copy, but takes the 
longest to print. Better Text produces high quality printed text by us
ing a font that's twice the size of the actual font you've used, then con
densing that font to half its size. 

Better Color. Produces a high quality printed copy and takes less time 
than Better Text to print. 

Draft. Produces a printed copy more quickly than either Better Text or 
Better Color. 
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Page range: 

All. All the pages of the document are printed. 

From: ___ To: ___ . Lets you pick a range of pages you want 
Teleworks Plus to print. Click the check box, then type the numbers of 
the first and last pages you want to have printed. 

Copies: 

If you want more than one copy, type the number of copies you want. 

Paper Feed: 

Automatic: For continuous computer paper. 

Manual. For single sheets of paper that you feed into the printer by 
hand, one at a time. 

Color. This option is for use only with applications such as Paintworks 
Gold, Writer's Choice elite, or Draw Plus that produce files that contain 
color. 

Laser Writer. If you chose Laser Writer in the Choose Printer dialog box, 
the Print dialog box has no Quality or Color settings. The other settings are 
the same as those for the ImageWriter. 

The buttons in the box give you these choices: 

OK. When you've selected the setting you want, click OK to start 
printing. 

Cancel. Click Cancel to return to the desktop without printing the 
document. Any settings you've changed return to the way they were 
originally. 

Send File/Cancel 

Use Send File to send a document to another computer or to " upload" a 
document to a bulletin board or information service. 

When you choose Send File, Cmcel appears on the menu in place of 
Send File. Use Cancel to stop sending a file. 

To use Send File: 

• Make sjre the settings in the File Transfer Setup dialog box are correct. 
(For more information, see " Transfer a File" under " Setup Menu" .) 
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• Establish communications with the computer or service you want to 
send a file to. 

• If you're asked to, type a name for the file you're about to send and a 
description of it; select the same protocol you chose in the File Transfer 
Setup dialog box. 

• Choose Send File from the File menu. 

The dialog box just like the Open dialog box appears. 

• Select the file you want to send. (The buttons in the box give you the 
same options as those explained under Open in the beginning of this 
section.) 

A second dialog box appears that displays the name of the file you've 
chosen to transfer and that lets you start the transfer. The buttons in the 
box give you these choices: 

Cancel. Click Cancel if you change your mind about starting the 
transfer. 

OK. Click OK to start the transfer. 

As the transfer is made, the dialog box displays the number of blocks send. 

• To stop sending a file before it has been completely transmitted, choose 
Cancel from the File menu, or press esc. 

Transfer Successful appears when the transfer has been completed. 

• Press any key to continue. 

The bulletin board or information service you're using returns to its nor
mal mode of operation. 

Receive File/Cancel 

Use Receive File to receive a document from another computer or to 
"download" a document from a bulletin board or information service. 

When you choose Receive File, Cancel appears on the menu in place of 
Receive File. Use Cancel to stop receiving a file. 

To use Receive File: 

• Make sure the settings in the File Transfer Setup dialog box are correct. 
(For more information, see " Transfer a File" under "Setup Menu".) 
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• Establish communications with the computer or service you want to 
receive a file from. 

• Select the file you want to receive, and select the same protocol you 
chose in the File Transfer Setup dialog box. 

The bulletin board or information service you're receiving the file from 
asks you to start the transfer. 

• Choose Receive File from the File menu. 

A dialog box appears that lets you start the transfer. The buttons in the box 
give you these choices: 

Cancel. Click Cancel if you change your mind about starting the 
transfer. 

OK. Click OK to start the transfer. 

As the transfer is made, the dialog box displays the number of blocks 
received. 

• To stop receiving a file before it has been completely transmitted, choose 
Cancel from the File menu, or press esc. 

Transfer Successful appears when the transfer has been completed. 

• Press any key to continue. 

The Save dialog box appears. The options the buttons give you are ex
plained under " Save:' 

Quit 

Use Quit to leave Teleworks Plus. You can't undo Quit once it has been 
carried out. 

To use Quit: 

• If you want to keep the document that's on the screen, save it. 
' 

• Choose Quit from the File menu, or hold down command and type Q. 

The entire screen is erased, and you can start another application. (If a 
dialog box appears that asks if you want to save the document currently 
on the desktop, see the instructions under " File" at the beginning of this 
section.) 
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1!!11'1. 
Und~ csz 
Cut esx 
Copy esc 
Paste esv 
Clear 

Select All (sR 

Edit Memo (sM 

Erose Memo 
~Capture 

Edit 

Undo 

Use Undo to cancel the last change you made to a procedure or document. 

Note: You can't use Undo to cancel any of the commands on the File 
menu. 

To use Undo: 

• IZhoose Undo from the Edit menu, or hold down command and type 

Cut 

Use Cut together with Paste to move text from one place in a procedure 
to another. You can also use Cut to place text on the Clipboard so you can 
use the text while you're telecommunicating (see Paste from more infor
mation.) 

To use Cut: 

• Select the text you want to cut. 

• Choose Cut from the Edit menu, or hold down command and type X. 

The text you've selected disappears from the procedure window and is 
placed on the Clipboard. You can now go to the new location and use the 
Paste command to place the text there. 

Copy 
Use Copy to make one or more copies of text that's in a document or pro
cedure. 
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To use Copy: 

• Select the text you want to copy. 

• Choose Copy from the Edit menu; you can also hold down command 
and type C. 

A copy of the text you've selected is placed on the Clipboard. 

• To insert a copy of the text in a procedure, use the Paste command. 

Paste 

Use Cut together with Paste to move text from one place in a procedure 
to another. Use Copy together with Paste to move text from a document 
to a procedure or to move text from one place in a procedure to another 
without erasing the text from its original location. 

You can also use Paste while you're telecommunicating to insert text on 
the Clipboard at a prompt just as if you 'd typed it there. 

To use Paste: 

• First select the text you want to use, then use Cut or Copy. (You can 
either cut or copy text from a procedure; you can only copy text from a 
document .) 

• Go to the place in the procedure you want to move the text to. 

• Choose Paste from the Edit menu, or hold down command and type V. 

Repeat the last two steps if you want to insert the text in more than one 
place. The text stays on the Clipboard until you cut or copy something 
else. 

Clear 

Use Clear to erase selected text from a procedure. 

To use Clear: 

• Select the text you want to erase. 

• Choose Clear from the Edit menu, or press delete . 
·, 

Select All 

Use Select All to select an entire document or procedure. 
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To use Select All: 

• Choose Select All from the Edit menu . 

The text of the entire document or procedure is highlighted to show that 
it's selected. 

Edit Memo/Stop Editing Memo 

Use Edit Memo to edit the document that 's currently in memory. 

When you choose Edit Memo, Stop Editing Memo appears on the menu 
in place of Edit Memo. When you're finished editing the text in the win
dow, use Stop Editing Memo to return to the communications screen. 

To use Edit Memo: 

• If you want to edit a document you've saved previously, open it . 

• Choose Edit Memo from the Edit menu, or hold down command and 
type M. 

A window appears on the desktop. Inside the window is the text of the 
document that's currently in memory. You can edit the text-insert, 
delete, cut, copy, and paste text-just as you would with any standard 
Apple IIGS word processor such as Writer's Choice elite. 

To use Stop Editing Memo: 

• Choose Stop Editing Memo from the Edit menu; hold down com
mand and type M; or click the Close box. 

The editing window closes. The changes you've made in the editing win
dow are reflected in the text in the communications area. 

Erase Memo 

Use Erase Memo to erase the text currently in memory. Erase Memo 
doesn't save the text before it erases it; if you want to save the text, use 
Save or Save As. 

To use Erase Memo: 

• Choose Erase Memo from the Edit menu. 

The text in memory is erased. 
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Capture 

Use Capture to store in memory all of the information that appears in the 
communications area. Capture is automatically selected when you start 
Teleworks Plus (a check mark next to Capture on the menu indicates that 
it's active). 

The amount of information you can store depends on how much memory 
there is in your computer. A message warns you when the memory is full. 
Capture is then deactivated and appears dimmed on the menu. 

Clear Screen c3 E 
Dial o number... c3 0 
Wait for o Call 
Hono Up c3 H 
Send o Breo~ c3 B 
Blind Mode 
Send ASCII Codes ... 
Automatic Ho ngup 

The Communications Menu 

Clear Screen 

Use Clear Screen to erase the text on the screen without changing the 
position of the cursor. · 

To use Clear Screen: 

• Choose Clear Screen from the Communications menu, or hold down 
command and type E. 

Dial a Number 

Use Dial a Number to dial the nwnber you want to connect to. 

To use Dial a Number: 

• Choose Dial a Number from the Communications menu, or hold 
down command and type D . 

A dialog box appears. The last number you dialed appears in the space to 
the right of Number to dial. If you've set a prefix, it appears below 
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Pref"tx (for more information about prefixes, see " Dialing an Outside 
Line" in Chapter 2). The dialog box lets you either select a number you've 
saved or type a new number and then dial it. You can also add numbers to 
the list, or change or erase numbers already on the list. 

• To enter a new number, double-click the number in the space to the 
right of Number to dial (to highlight it), then type the new number; the 
previous number is erased automatically. 

• To select a number you've saved, point to the name on the Jist that iden
tifies the number and click the mouse button. 

• To change or erase a number you've saved, first select the name that 
identifies the number, then click either the Modify or the Delete but
ton. (See the Modify or the Delete button for further instructions.) 

• To add a number, click the Add button. (See the Add button for further 
instructions.) 

The buttons in the box give you these options: 

OK. Click OK to dial the number that appears in the space next to 
Number to dial. 

Cancel. Click Cancel to return to the communications area w ithout 
dialing a number. 

Modify. Click Modify to change the number or modem settings you've 
saved with the name that's selected. 

A dialog box appears. 

• Change or edit the name and number displayed in the box any way 
you want. 

• To change the modem settings, point to the setting you want to 
change, and keep clicking the mouse button until the setting you want 
appears. 

The buttons give you these options: 

OK. Click OK to save the changes you've made and return to the Dial 
a Number dialog box. As soon as the connection is made, the counter 
at the top of the communications area is reset to zero to monitor the 
new session. 

If a message box appears that says the modem doesn't answer, your 
modem may be unplugged, defective, or not operating properly for 
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some reason. Check the modem; refer to the user's guide that came 
with it if you need help. 

Cancel. Click Cancel to return to the Dial a Number dialog box 
without saving the changes you've made. 

Add. Click Add to save a new number. 

The dialog box explained under the Modify button appears; you use it 
the same way. 

Delete. Click Delete to erase the name that's selected and the 
number and modem settings you saved with it. 

Wait For A Call 

Use Wait for a Call to let another computer connect to yours (your com
puter becomes the " host"). To use Wait for a Call, you have to have an 
auto-answering modem. 

To use Wait for a Call: 

• Choose Wait for a Call from the Communications menu. 

When a call comes in, Teleworks Plus answers it on the third ring and tries 
to make a connection. If it can't make a connection in about 20 seconds it 
hangs up and waits for the next call. ' 

If a message box appears that says the modem doesn't answer, your 
modem may be unplugged, defective, or not operating properly for some 
?ther reason. Check the modem; refer to the user's guide that came with it 
1f you need help. 

Hang Up 
Use Hang Up to end a session. 

To use Hang Up: 

• Choose Hang Up from the Communications menu, or hold down 
command and type H. 

The connection is broken, and the clock at the top of the communications 
area stops-. 
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Send a Break 

Use Send a Break to send a BREAK signal to the service you're connected 
to. 

The BREAK signal makes it possible to re-initialize some services and to 
return to the main menu. (For more information see the user's guides for 
the services you use.) 

To use Send a Break: 

• Choose Send a Break from the Communications menu, or hold down 
command and type B. 

Blind Mode 
Use Blind Mode if you don't want what you're typing to appear in the 
communications area. 

Blind Mode lets you type confidential information, such as a password. 
Each time you type a character, only a dot appears on the screen. Blind 
Mode is canceled when you press return. 

To use Blind Mode: 

• Choose Blind Mode from the Communications menu. 

A check mark appears next to Blind Mode on the menu. A dot appears in 
the communications area each time you type a character. 

• To cancel Blind Mode, press return. 

Send ASCII Codes 
Use Send ASCII Codes to enter an ASCII code in decimal, from 0 to 255. 
Teleworks Plus will send the character that corresponds to the ASCII code. 

To use Send ASCII Codes: 

• Choose Send ASCII Codes from the Communications menu. 

A dialog box appears. 

• Type the decimal value of the ASCII code you want to send in the space 
provided. 
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The buttons in the box give you these options: 

OK. Click OK to send the ASCII code you've typed and to remove the 
dialog box from the communications area. 

Cancel. Click Cancel to remove the dialog box from the communica
tions area without sending an ASCII code. 

Next Code. Click Next Code to send the ASCII code you've typed and 
keep the dialog box on the screen so you can send another ASCII code. 

Automatic Hang-up 

Use Automatic Hang-up to set the length of time you want a session to 
last. Teleworks Plus breaks the connection automatically when the time is 
up. 

To use Automatic Hang-up: 

• Choose Automatic Hang-up from the Communications menu. 

A dialog box appears. 

• Enter the time you want the session to last in the three boxes: the left 
box is for hours, the middle box for minutes, and the right box for 
seconds. 

• Click the check box to the left of Hang-up after to activate the Automatic 
Hang-up clock. 

The buttons in the box give you these options: 

OK. Click OK to record the time you've entered. If you've clicked the 
check box next to Hang up after, the Automatic Hang-up clock will start 
as soon as you start the next communications session. 

Cancel. Click Cancel to return to the communications area without 
saving the changes you made in the dialog box. 

·, 
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Record o Procedure 

Write a Procedure .. . 

Edit a Procedure .. . 

Startup Procedure ... 

Wait for Characters ... es W 

Pause 

The Procedures Menu 

Run/Stop a Procedure 
Use Run a Procedure to select and use a procedure you've saved. When 
you choose Run a Procedure, Stop a Procedure appears on the menu 
in place of Run a Procedure. 

To use Run a Procedure: 

• Choose Run a Procedure from the Procedures menu. 

A dialog box appears. 

• Select the procedure you want to use, then click Open. 

Teleworks Plus runs the procedure. (You can't use the keyboard while the 
procedure is running.) 

• To stop the procedure that's running, choose Stop a Procedure from 
the menu. 

The buttons in the dialog box work the same as they do in the Open dialog 
box. 

Record a Procedure/Stop Recording 
Use Record a Procedure to save a procedure as you're using it. Record 
a Procedure lets you save a procedure during a communications session; 
Write a Procedure (which is explained next) lets you create a procedure 
when you're not communicating with a service or another computer. 

When you choose Record a Procedure, Stop Recording appears on the 
menu in place of Recording a Procedure. 

To use Record a Procedure: 

• Before you start the procedure you want to save, choose Record a 
Procedure from the Procedures menu. 
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To use Record a Procedure: 

• Before you start the procedure you want to save, choose Record a 
Procedure from the Procedures menu. 

Teleworks Plus records all the characters you type and any functions you 
use. 

• To stop recording, choose Stop Recording from the menu. 

A dialog box appears. 

• Give the procedure you've just recorded a name, then click Save. 

The buttons in the box work the same as they do in the Save dialog box. 

Write a Procedure 
Use Write a Procedure to create a "script" for a procedure using pro
cedure commands. Write a Procedure lets you create a procedure when 
you're not communicating with a service or another computer; Record a 
Procedure (which is explained just before this command) lets you save a 
procedure as you use it during a communications session. 

To use Write a Procedure: 

• Choose Write a Procedure from the Procedures menu. 

A window appears. 

• Type the steps of the procedure (the commands you can use are listed in 
Appendix A, " Procedure Commands"). You can edit the text-insert, 
delete, cut, copy, and paste text-just as you would with any standard 
Apple IIGS word processor such as Writer's Choice elite. You can enter 
text in either upper- or lower-case letters; spaces are ignored. 

• When you've completed the procedure, click the Close box at the left 
end of the title bar. 

A dialog box appears that asks if you want to save the modifications 
you've made. The buttons in the box gives you these options: 

Yes. Click Yes to save the procedure you've written. The Open dialog 
box appears. The options that the buttons give you are explained under 
" Open" under "File Menu:' 

No. Click No to close the window without saving the procedure. 

Cancel';- Click Cancel to return to the window to add or make changes 
to the procedure. 

------------------------------------------61 



Teleworks Plus 

Edit a Procedure 
Use Edit a Procedure to make changes to a procedure you've saved. You 
can edit a procedure during a communications session. 

To use Edit a Procedure: 

• Choose Edit a Procedure from the Procedures menu. 
A dialog box appears. 

• Select the procedure you want to edit, then click Open. (The buttons in 
the box work just as they do in the Open dialog box.) 

A window appears with the text of the procedure in it. 

• Make whatever changes you want to the procedure. You can edit the 
text-insert, delete, cut, copy, and paste text-just as you would with 
any standard Apple IIGS word processor such as Writer's Choice elite. 
You can enter text in either upper- or lower-case letters. 

• When you've finished editing the procedure, use either Save or Save As 
to save the new version. 

Start-up Procedure 
Use Start-up Procedure to select the procedure you want Teleworks 
Plus to run whenever you start the program. 

To use Start-up Procedure: 

• Choose Start-up Procedure from the Procedures menu. 

A dialog box appears. 
• Select the name of the procedure you want to be the start-up procedure, 

then click Open. 
The procedure is added to the list with the name "Startup." Whenever 
you start Teleworks Plus, it automatically runs the procedure named 
"Startup: ' 

The buttons in the dialog box work the same as they do in the Open dialog 
box. 

Wait for Characters 
Use Wait for Characters to keep a procedure from starting until 
Teleworks Plus receives a certain string of characters from the computer 
or service you're connected to. Wait for Characters lets you make sure 
your computer and the computer or service you're connected to are syn
chronized before the procedure begins. 
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Wait for Characters is active only when you're recording a procedure. 

To use Wait for Characters: 

• Choose Wait for Characters from the Procedures menu, or hold 
down command and type W. 

A dialog box appears. These are the settings it contains: 

Wait for Characters: ___ . If Record a Procedure was active 
before Teleworks Plus received the last prompt, the final four characters 
of that prompt appear in the space to the right of Wait for Characters. 
You can then replace whatever text appears in the space if it doesn 't 
match the text you want Teleworks Plus to wait for. 

Goto if not received after __ seconds. Click 
the box next to Goto if you want to provide Teleworks Plus with an 
alternative in case the characters you have instructed it to wait for aren't 
transmitted. In the space to the right of Goto, type the alternative text 
you want Teleworks Plus to wait for. In the space to the left of seconds, 
type the number of seconds you want Teleworks Plus to wait before it 
goes to the alternative. 

The buttons in the box give you these choices: 

OK. Click OK to record the settings you've entered. 

Cancel. Click Cancel to remove the dialog box from the communica
tions area without recording characters you want Teleworks Plus to 
wait for. 

Note: If the text Teleworks Plus is waiting for isn't received when you're 
running the procedure, choose Stop a Procedure. You can continue 
with the session by entering whatever information is needed yourself. 

Pause 

Use Pause to stop the exchange of information for about a second. You 
can use Pause in place of Wait for ~haracters when there are no specific 
characters you can have Teleworks Plus wait for. 

Pause is active only when you're recording a procedure. 

To use Pause: 

• Choose Pause from the Procedures menu. 

Teleworks Plus adds a Pause instruction to the procedure you're recording. 
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The Setup Menu 

Terminal 

TermmaL. 
Modem ... 

Transfer a File 
Macros Keus 
Dialing Prefix 
Choose Interface/Modem 
Save Setup .. . 
Load Setup .. . 

Use Terminal to set up the way you want Teleworks Plus to work as a 
terminal. 

To use Terminal: 

• Select Terminal from the Setup menu. 

A dialog box appears. 

• To select a setting, click the check box to the left of it. An X appears in 
the box. 

• To remove the X from a check box, click the box again. 

These are the settings you can choose from: 

Local Echo. Displays in the cominunications area whatever you type 
and send to the computer or service you're connected to. If the 
characters that you type appear twice, it means the service or computer 
you're connected to is set up to send back to you the characters it 
receives; if that's the case, don't select Local Echo. 

Word Wrap. Moves a word that won't fit at the end of a line to the 
beginning of the next. If you don't choose Word Wrap, every letter you 
type once you reach the end of the line appears in succession at the end 
of the line. 

Send a LF after a CR. Sends a line feed after every carriage return you 
type. 

Automatic LF after CR while receiving. Follows every carriage 
return you receive with a line feed. 
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Automatic CR after LF while receiving. Follws every line feed you 
receive with a carriage return. 

Automatic CR after ___ Characters. Inserts a carriage return and 
line feed each time you receive a given number of characters from the 
computer or service you're connected to. The preset number is 80, 
which is the width of the communications area. 

Automatic scrolling. Moves all of the text in the communications area 
up one line when the screen becomes filled so that there's room for the 
next line at the bottom of the screen. The line at the top of the com
munications area disappears. 

If you don't select Automatic scrolling, the communications area is 
erased each time it fills up. New text appears starting at the top of the 
communications area. 

Display Control Characters. Displays control characters (carriage 
return, page feed, line feed, audible signal, escape, and so on) in reverse 
video. If you don't select this setting, control characters aren't displayed. 

Erase when Backspacing. Lets you erase the character preceding the 
cursor with the delete key. 

Smooth Scrolling. Slows down the speed text is displayed. When 
you're using a fast communications speed, such as 1200 baud, Smooth 
Scrolling makes it possible for you to read the text as you receive it. 

Blank Screen after ___ minutes. Changes the screep. to black if 
you haven't interacted with the program for a given number of minutes. 
Blanking the screen keeps the image that's there from burning per
manently into the phosphorescent coating on the inside of the tube. 
Nothing on the screen is changed; you can display the image again by 
clicking the mouse button or pressing any key. 

The buttons give you these options: 

OK. Click OK to record the settings you've selected and go back to the 
communications area. (To save the settings permanently, choose Save 
Setup from the Setup menu.) 

Cancel. Click Cancel to ignore any changes you've made and go back 
to the communications area. 
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Modem 

Use Modem to select the setting for the modem you're using. 

Note: When you choose a modem from the Interface/Modem dialog box, 
Teleworks Plus automaically selects the modem settings normally used 
with the modem you've chosen. Check the user's guides for your modem 
and the service you're using before you make any changes. 

To use Modem: 

• Choose Modem from the Setup menu. 

A dialog box appears. 

• To select a setting, point to either the button or the check box to the left 
of it and click the mouse button. Settings that are dimmed aren't 
available with the modem you've chosen. 

These are the features you can select a setting for: 

Speed. The speed at which you want the modem to send and receive in
formation .. 

Format. The format you want information sent and received in. 

Parity. The parity you want to use. 

Stop Bits. The number of stop bits you want to use. 

Dialing. Select the type of dialing you want to use. 

Modem Type. Select the type of network you're calling out on. 

Xon/Xoff X on Char. X off Char. Click the check box 
next to select the Xon/Xoff protocol. If you need to change the Xon and 
Xoff characters, type a value in each box. (The bulletin board or infor
mation service you're using tells you if you need to use Xon/Xoff and 
what the correct settings are.) 

Require Carrier Detect. A carrier is a tone emitted by a modem that 
means it's ready to communicate. Click the check box if your modem 
can't transmit the carrier to your computer. Your computer then acts as 
if it has detected the carrier. 

Echo Received Characters. Click the check box to send every 
character your computer receives back to the sender. The echo makes it 
possible for the sender to check whether the information is being sent 
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correctly. (An X in the check box means Teleworks Plus is operating at 
full duplex; no X means it's operating at half duplex.) 

The buttons in the box give you these options: 

OK. Click OK to record the settings you've selected and go back to the 
communications area. (To save the settings permanently, choose Save 
Setup from the Setup menu.) 

Cancel. Click Cancel to ignore any changes you've made and go back 
to the communications area. 

Transfer a File 

Use Transfer a File to set up the protocol you want to use when you send 
information to another computer. 

To use Transfer a File: 

• Choose Transfer a File from the Setup menu. 

A dialog box appears. 

• To select a setting, click the button or check box to the left of the setting 
you want to use. 

These are the settings you can choose from: 

Protocol: 

ASCII. Use to send text-only files. When you choose ASCII, check the 
settings under "ASCII Transfer" to make sure they're correct. 

XModem (Teleworks). Use to send a file to another Apple IIGs that's 
using Teleworks Plus. The other computer will receive the file exactly as 
you send it. 

XModem. Use to send a file with the standard XModem protocol. 
XModem is a standard error-correction protocol. 

None. Use to send a file with any protocol or to operate locally. 

YModem. Use to send multiple files with the standard YModem pro
tocol. 

ASCII transfer: 

Delay Between Characters (ms): ___ . The number of milliseconds 
you want Teleworks Plus to wait to send a character after it sends or 
receives another character. 
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Delay After CR (1/lOs): ___ . The length of time (in tenths of 
seconds) you want Teleworks Plus to wait to send a character after it 
sends a carriage return. A delay after carriage return controls the trans
mission of characters better than a delay between characters because it 
keeps Teleworks Plus from sending the next line of text before the time 
you've given has elapsed. 

Wait for a prompt at the beginning of line ___ . If you want 
Teleworks Plus to wait for a specific character before starting to send a 
file, click the check box and type the character you want Teleworks Plus 
to wait for. (Teleworks Plus will start sending the file in 20 seconds if it 
doesn't receive the character.) 

Force CR after ___ Characters. If you want to set the width of text 
as it's received, click the check box and type the number of characters 
you want to appear in each line. 

No Word-Wrap. Click the check box to wrap around to the next line a 
word that won't fit at the end of the previous line. Otherwise, Teleworks 
Plus breaks a word where the line ends and displays the rest of the word 
on the next line. 

Wait for Echoed Characters. Click the check box if you want 
Teleworks Plus to send a character only after it receives an echo of the 
previous character it sent. Waiting for an echo guarantees that all the 
characters you send are received. 

Beep when finished. Click the check box if you want Teleworks Plus 
to beep when it has finished sending the file. 

The buttons in the box give you these options: 

OK. Click OK to record the settings and go back to the communications 
area. (To save the settings permanently, choose Save Setup from the 
Setup menu.) 

Cancel. Click Cancel to ignore any changes you've made and go back 
to the communications area. 

Macros Keys 
Use Macros Keys to assign up to 16 characters to one of the number keys. 
Then, whenever you hold down optton and type the number, all the 
characters you assigned to it appear just as if you'd typed them. Macro 
keys are good for words, phrases, or numbers you use often (for example, 
your Activision BBS ID number). 
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To use Macros Keys: 

• Choose Macros Keys from the Setup menu. 

A dialog box appears. 

Reference 

• To assign text to a key, type it in the space to the left of the key you want 
to assign it to. 

The buttons in the box give you these options: 

OK. Click OK to record the text you've assigned to the macro keys and 
go back to the communications area. (To save the text permanently, 
choose Save Setup from the Setup menu.) 

Cancel. Click Cancel to ignore any changes you've made and go back 
to the communications area. 

Dialing Prefix. Use this option if you have to dial a prefix in order to 
get an outside line. For example, if you have to dial9 every time you dial 
out, enter 9 in the Dialing Prefix box. 

Choose Interface Modem 
Use Choose Interface/Modem to set up Teleworks Plus to work with 
your interface card and modem. 

To use Choose Interface/Modem: 

• Select Choose Interface/Modem from the Setup menu. 

A dialog box opens. The catalog on the left lists interface cards Teleworks 
Plus is set up to work with. The catalog on the right lists the modems 
Teleworks Plus is set up to work with. 

• Point to the name of the interface card you're using and click the mouse 
button. If your card doesn't appear on the list, select Serial Port. 

• Point to the name of the modem you're using and click the mouse but
ton. If your modem doesn't appear on the list, select Other RS232. The 
modem you choose affects the settings in the Modem dialog box (see 
"Modem" earlier in this section for more information). 

The buttons in the box give you these options: 

OK. Click OK to record the interface card and modem you've selected 
and go back to the communications area. (To save the selections you've 
made permanently, choose Save Setup from the Setup menu.) 

Cancel. Click Cancel to ignore any changes you've made and return to 
the communications area. 
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Save Setup 
Use Save Setup to save permanently the current settings in all of the 
Setup menu dialog boxes. 

To use Save Setup: 

• Choose Save Setup from the Setup menu. 

A dialog box appears. 

• Type a name for the settings in the space under Save As. 

• To have Teleworks Plus use the settings you're saving as soon as you 
start it, click the check box to the left of Use at Startup at the bottom of 
the box. 

The buttons in the box give you these options: 

Save. Click Save to save the settings. 

Open. If you want to save the settings in a folder , select the folder from 
the catalog and click Open. 

Close. You can use Close only if a folder is open. Click Close to close 
the folder. 

Folder. To create a new folder, type a name for it in the space under 
Save As, then click Folder. Use Open to open the folder whenever you 
want to save settings in it . 

Drive. If you want to save the settings on a disk other than the one in 
the drive, replace the disk in the drive with the new disk. Click Drive to 
display the names of the documents on the new disk. 

Cancel. Click Cancel if you decide not to save the settings. 

Use at Startup. If you want the current settings to be loaded every time 
you start Teleworks Plus, click Use at Startup. 

Load Setup 
Use Load Setup to get settings you've saved on a disk. 

To use Load Setup: 

• Choose Load Setup from the Setup menu. 

A dialog box appears. 

• Select the name of the settings you want to use, and click Open. 

The buttons in the dialog box work the same as they do in the Open dialog 
box. 
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The Binary II Menu 

Unpack 

Use Unpack to return documents compressed using Binary II to their nor
mal format. 

To use Unpack: 

• Choose Unpack from the Binary II menu. 

A dialog box appears. 

• Select the name of the Binary II file that contains the documents you 
want to return to normal. 

• Click Open. (The buttons in the dialog box work the same as they do in 
the Open dialog box.) 

After Unpack returns each document to normal, it automatically saves 
each one separately in the folder that's currently open. 

Pack 

Use Pack to save documents in Binary II's compressed form:it (compress
ed documents take less time to send and receive than documents in their 
normal format). You can compress and save more than one document in a 
single Binary II file . 

The person you send compressed documents to needs a Binary II utility to 
return the documents to their original format . (The person doesn't, 
however, need Teleworks Plus; there are many telecommunications ap
plications that can handle Binary I!-) 

To use Pack: 

• Choose Pack from the Binary II menu. 

A dialog b6x appears. 

• Select the document you want to compress, then click the Open/Add 
button. If you want to compress more than one document, select them 
one at a time and click Open/Add after each one. 
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• When you've selected all the documents you want to compress, click 
Done. 

Another dialog box appears. 

• Type a name for the Binary II file that contains the compressed 
documents. (It's a good idea to make something like B/1 part of the name 
of the file so you can distinguish compressed files from normal 
documents. 

• Click Save. 

A message box appears that lists each document as Teleworks Plus com
presses and saves it. When the message box disappears , all the documents 
you've selected have been compressed and saved. 
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active window 

The window that's in front of the others; its title bar has four parallel lines, 
stretching from one end to the other. It's the window where you're cur
rently working. 

ASCII 

American Standard Code for Information Interchange. A standard way of 
translating text into a numerical code and back again. It's used to transfer 
information between applications and between computers. 

auto answer 

A feature that enables a modem to automatically detect an incoming call 
and connect with the phone line it's on. 

auto dial 

A feature that enables a modem to connect with a phone line and dial a 
number automatically. 

auto hang-up 

A feature that enables a modem to end a connection with a phone line 
automatically. 

baud rate 

A way of measuring transmission speed, roughly equal to the number of 
bits of information transmitted in a second. Most modems transmit infor
mation at 300, 1200, or 2400 baud. The abbreviation bps (bits per second) 
means approximately the same thing. 

Bell 

Signifys m9dems that confirm to the transmission standards developed by 
AT&T. 
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binary rue 
A file that contains information recorded in the simplest form. Binary files 
are usually used to transmit application files . 

Binary II 

A method of storing files that lets you send and receive files with their 
original attributes intact. 

bit 

The smallest piece of information a modem can send or receive. The speed 
at which a modem can send or receive information is measured in bits per 
second. 

branch 

Teleworks Plus usually follows a procedure line by line from top to bot
tom. Sometimes, however, Teleworks Plus skips part of a procedure or 
jumps from one part to another to take care of special circumstances that 
arise (for example, if it's waiting to receive a certain word or phrase, and a 
different one is sent). Any place in a procedure that Teleworks Plus can 
skip to or jump to is known as a branch. 

break 

A signal that makes it possible to re-initialize some services and to return 
to the main menu. (For more information about what a break can do, see 
the user's guides for the services you use.) 

buffer 

A place in the computer's memory where information is stored temporarily. 

byte 

A group of consecutive bits forming a unit of storage in the computer 
and used to represent one alphanumeric character: a byte usually con
sists of 8 bits but may contain more or fewer bits depending on the 
model of computer. 
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Capture 

The command that tells Teleworks Plus to automatically store in memory 
all the information that appears on the screen during a session. 

carrier 

A signal that indicates that a computer is ready to transmit and receive in
formation through a modem. 

CCITT 

Abbreviation for Consultive Committee for International Telegraph and 
Telephone; an advisory committee established under the United Nations 
to recommend worldwide standards for data and voice transmission. 

character 

A character is any single letter, numeral (1, 2, 3, ... ), punctuation mark 
(comma, period, and so on), symbol (%, S, ... ), or space. 

checksum 

A method for detecting if any errors have been introduced into a file while 
it was being transmitted. The number of pieces of information in the file 
that has been received is checked against the number of pieces of informa
tion in the file that was sent. 

control character 

A character that makes Teleworks Plus (or the service it's connected to) do 
something. It 's different from a display character (such as a letter, number, 
or symbol), which appears on the screen. For example, breaks, line feeds, 
and carriage returns are all caused by control characters. 

dial pulse 

A feature modems have that allows them to produce the clicks a rotary dial 
phone makes when you dial it. 

dial tone 
·, 

1. A feature moderns have that allows them to produce the sounds a Touch
Tone phone makes when you dial it. 

2. The hum a phone line makes when it's not in use. 
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disconnect 

To end a call. You can disconnect intentionally (for example, when you 
hang up), or it can happen by accident (for example, if there's a problem 
on the service or bulletin board you're connected to) . 

download 

To receive a file from an information service, a bulletin board, or another 
computer. 

duplex 

The kind of transmission that allows information to go in both directions 
at the same time (also called full duplex). Half-duplex transmission allow 
information to go in both directions, but not at the same time. 

echo 

To display (or verify) on the sender's system what's being received by the 
receiver's system. 

execute 

To carry out a command or procedure. 

flow control 

A way of controlling the flow of data by starting and stopping what one 
computer is sending/receiving to another. The receiver sends an Xoff 
character to stop the sender, and an Xon character to restart it. 

handshake 

A set of rules about the process of communicating that the computers at 
both ends of a connection follow. For example, one of the rules tells both 
computers when to start transmitting information and when to stop. 

host 

The information service, bulletin board, or computer that you connect 
with. If you set up your computer to receive calls from other computers, 
your computer becomes the host. 
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line feed 

A control command that moves the cursor down to the next line. 

local 

Having to do with your system rather than the service or bulletin board 
you're using. For example, saving a document is a local operation because 
you save it on the disk drive attached to your computer; uploading a docu
ment isn't a local operation because it involves transferring the document 
to a different system. 

log on/off 

Log on means to call an information service, a bulletin board, or another 
computer and identify yourself to it. Log off means to notify the host that 
you're leaving and then to disconnect. 

menu 

A list of op~ons or commands you can choose from. 

modem 

A device that lets a computer transmit information to and receive informa
tion from another computer (also equipped with a modem) over a 
telephone line. 

null 

A character used to denote the absence of information which can be in
serted or deleted in a sequence without affecting the meaning of the se
quence. Nulls are generally used as communications control characters to 
fill time in synchronous transmissions. 

offline 

Not connected to a service or bulletin board. For example, you can write a 
message off line, then sign on to a service to send it. 

on line ·, 

Connected to a service or bulletin board. For example, you have to be on 
line to upload or download documents. 
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parity (odd and even) 

A method of detecting errors in a transmission of information. Odd and 
even parity both use an extra bit added to an ASCII code to check for errors. 

procedure 

A list of instructions you can create for Teleworks Plus to follow if you 
want to carry out certain operations (such as signing on to a service) 
automatically. 

prompt 

Text that a service or bulletin board displays on your screen to ask you to 
make a choice or type information (for example, Who is tbe message to?) 
or simply to indicate the type of choice or information you can enter (for 
example, Command:). A prompt remains on the screen until you respond 
to it. 

protocol 

A set of rules that the computers at both ends of a connection follow to 
make sure that the file that's received is the same as the file that was sent. A 
protocol contains, among other things, ways to check for errors that have 
been introduced into a file during its transmission. 

RS-232C 

A special type of connector designed for connecting such things as com
puters, modems, and communications lines. 

serial 

Transferring information one bit at a time (rather than transferring several 
bits simultaneously). 

smart modem 

A modem that can cary out certain operations, such as answering a call or 
dialing a number, automatically. 

stop bit 

The bit that signals the end of the data being transmitted. 
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string 

Any series of characters. For example, a word or phrase is a text string; a 
telephone number is a numeric string. 

sysop 

The person who manages a bulletin board. 

TTY 

An abbreviation for teletypewriter. A device for automatically printing 
received messages. 

upload 

To transmit a file to an information service, bulletin board, or another 
computer. 

window 

An area where you can create or change a procedure or file. You can open 
or close a window, move it around, change its size, scroll through it, and 
edit its contents. 

XModem 

A standard set of rules that check for errors when information is transmit
ted from one computer to another. 

Xon/Xoff 

A standard handshake protocol (that is, a set of rules about the process of 
communicating that the computers at both ends of a connection follow). 

·, 
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Appendix A 
______ Procedure Commands 

This appendix lists the commands you can use in writing or editing a pro
cedure. 

To use commands in Teleworks Plus, use a single left angle bracket ( < ) 
before the command and a single right angle bracket ( >) after the com
mand. If you want Teleworks Plus to send text as if you were typing it 
from the keyboard, type two left angle brackets ( < < ), type the text you 
want to send-including tabs, spaces, returns, and so on-then type two 
right angle brackets ( > > ). the result looks something like this: 

<text> 

ASCII. Abbreviation for American Standard Code for Information Inter
change. A standard 7-bit coded word that allows information to IX: inter
changed between Teleworks Plus and other computers. 

Format: <ASCII> 

Beep. Use Beep if you want Teleworks Plus to beep when it has finished 
sending a file. 

Format: <Beep> 

(See "Beep when finished" under "Transfer a File" in the "Reference" 
section.) 

Break. Use Break to stop Teleworks Plus from carrying out a procedure. 

Format: <Break> 

Carrier. Use Carrier if your modem can't transmit a carrier to your com
puter (a carrier is a tone emitted by a modem that means it's ready to com
municate). Your computer then acts as if it has detected the carrier. 

Format: <Carrier> 

(See "Require Carrier Detect" under "Modem" in the "Reference" 
section.) 

ClrMem. Use ClrMem to erase the text currently in memory. 

Format: <ClrMem> 

(See "Erase Memo" in the "Reference" section.) 

ClrScreen. Use ClrScreen to erase the text on the screen without chang
ing the position of the cursor. 
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Format: <ClrScreen> 

(See "Clear Screen" in the "Reference" section.) 

CR. Use CR to send a carriage return. 

Format: <CR > 

Delete. Use Delete to remove a document from the disk where it's saved. 
Be careful when you use Delete in a procedure: Teleworks Plus doesn't 
ask you to confirm that you want it to delete the document you've named. 

Format: <Delete "name"> 

Replace name with the name of the document you want to delete. 

Dial. Use Dial to dial the number you want to connect to. 

Format: <Dial "number" > 

Replace number with the phone number you want to dial. You can in
clude a prefix and an area code. Don't put any punctuation, such as dashes 
or parentheses, when you type in the number. 

(See "Dial a Number" in the "Reference" section.) 

DialPref. Use DialPref to record a prefix you want Teleworks Plus to 
dial before every number it dials (for example, a prefix that connects you 
with an outside line). 

Format: < DialPref "prefix" > 

Replace prefix with the number and symbols you want Teleworks Plus to 
dial before every number. A prefix can contain a comma (which causes a 
pause), an asterisk("), or a pound sign(#), as well as numbers. 

(See "Dialing Prefix" in the "Reference" section.) 

Echo. Use Echo to send every character your computer receives back to 
the sender. The echo makes it possible for the sender to check whether the 
information is being sent correctly. Use On after Echo to have Teleworks 
Plus operate at full duplex; use Off after Echo to operate at half duplex. 

Format: < Echo on or Echo Off > 

(See "Echo Received Characters" under "Modem" in the "Reference" 
section.) 

EditMem. Use EditMem to edit the document that's currently in memory. 
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Procedure Commands 

Format: <EditMem> 

(See " Edit Memo" in the " Reference" section.) 

End. Use End at the end of a procedure that's not at the end of a pro
cedure file . For example, if you write a procedure that incorporates 
several different procedures each of which you want Teleworks Plus to 
branch to under certain conditions, you'd use End at the end of each of 
those procedures. 

Format: <End> 

Goto. Use Goto if you want to provide Teleworks Plus with an alternative 
in case the characters you have instructed it to wait for with the Wait 
command aren't transmitted. 

Format: <Goto "text,seconds" > 

Replace text with the alternative text you want Teleworks Plus to wait for. 
Replace seconds with the number of seconds you want Teleworks Plus to 
wait before it goes to the alternative. 

(See "Wait for Characters" in the " Reference" section.) 

Hangup. Use Hang Up to end a session. The connection is broken, and 
the clock at the top of the communications area stops. 

Format: <Hangup> 

(See "Hang Up" in the "Reference" section.) 

Info. Use Info in a procedure to display Teleworks Plus' About dialog 
box. 

Format: <Info> 

Label. Use Label to identify a portion of a procedure with a name. This 
command works much like a Pascal or Basic label; it tells Teleworks Plus 
what part of the procedure to jump to when you use the < Goto 
"labelname" > 
Format: <Label "labelname"> 

Link. Use Link to stop the current procedure that is running and start ex
ecuting another specified procedure stored on disk. 

Format: <Link "filename"> 

LoadSetup. Use LoadSetup to get settings you've saved on a disk. 

Format: -2LoadSetup "name" > 

(See "Load Setup" in the " Reference" section.) 
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Lock. Use Lock to protect a document so that you can' t write over it or 
delete it using Teleworks Plus or any other application. 

Format: <Lock "name" > 
Replace name with the name of the document you want to lock. 

Memorize. Use Memorize to store in memory all of the information that 
appears in the communications area. (Capture-the menu equivalent of 
Memorize-is automatically selected when you start Teleworks Plus.) 

Format: <Memorize> 

(See "Capture" in the " Reference" section.) 

Message. Use Message to have Teleworks Plus notify you when a pro
cedure detects a specific word or phrase. You can use Message, for exam
ple, if you're waiting for a message about a specific topic. 

Format: <Message "text" > 

Replace text with the word or phrase you want Teleworks Plus to watch 
for. 
Off. Use Off after Echo if you want Teleworks Plus to operate at half 
duplex. 

Format: <Echo Off> 
(See "Echo Received Characters" under " Modem" in the "Reference" 
section. 
On. Use On after Echo if you want Teleworks Plus to operate at full 
duplex. 

Format: <Echo On> 
(See "Echo Received Characters" under "Modem" in the "Reference" 
section.) 
OpenASCII. Use OpenASCII to open a ftle saved in ASCII format. 

Format: <OpenASCII "name"> 

Replace name with the name of the ftle you want to open. 

Pause. Use Pause to stop the exchange of information for about a 
second. You can use Pause in place of Wait when there are no specific 
characters you can have Teleworks Plus wait for. 

Format: <Pause> 

(See "Pause" in the "Reference" section.) 
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Print. Use Print to print text as you receive it. 

Format: <Print> 

Procedure Commands 

(See " Continuous Printing" in the " Reference" section.) 

Quit. Use Quit to leave Teleworks Plus. 

Format: <Quit> 

(See " Quit" in the " Reference" section.) 

Rec~ive:ralk. Use ReceiveTalk to receive a ftle from another Apple IIGs 
that s usmg Teleworks Plus. You will receive the file exactly as the other 
computer sends it. 

Format: <ReceiveTalk> 

(See " Xmodem (Teleworks)" under " Transfer a File" in the " Reference" 
section.) 

ReceiveXmodem. Use ReceiveXmodem to receive a file with the stan
dard XModem protocol. 

Format: < ReceiveXmodem > 

(See " Xmodem" under " Transfer a File" in the " Reference" section.) 

ResetTempo. Use ResetTempo to reset the Time counter. 

Format: ResetTempo 

SaveASCII. Use SaveASCII to save a file in ASCII format . (In ASCII for
mat, Teleworks Plus saves only text-not fonts , font sizes or styles, or 
graphics.) 

Format: < SaveASCII "name" > 

Replace name with the name you want to give the file you're saving. 

SaveSetup. Use SaveSetup to save permanently the current settings in all 
of the Setup menu dialog boxes. 

Format: <SaveSetup "name"> 

Replace name with the name you want to give the setup you're saving. 

(See " Save Setup" in the " Reference" section.) 

SendASCII. Use SendASCU to send only the text of a document (not the 
format setting, fonts, styles, and so on). When you use SendASCII, check 
the settings under "ASCII Transfer" in the File Transfer Setup dialog box 
to make sure they're correct. 
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Format: < SendASCII "name" > 

(See "ASCII" under "Transfer a File" in the "Reference" section.) 

SendBreak. Use SendBreak to tell the service, bulletin board, or com
puter Teleworks Plus is communicating with to stop whatever it's doing. 

Format: <SendBreak> 

SendTalk. Use SendTalk to send a me to another Apple IIGS that's using 
Teleworks Plus. The other computer will receive the me exactly as you 
send it. 

Format: <SendTalk > 

(See "Xmodem (Teleworks)" under "Transfer a File" in the "Reference" 
section.) 

Send.Xmodem. Use Send.Xmodem to send a file with the standard 
XModem protocol. 

Format: <Send.Xmodem > 

(See "Xmodem" under "Transfer a File" in the "Reference" section.) 

Unlock. Use Unlock to remove the protection from a document that 
keeps you from writing over it or deleting it . 

Format: <Unlock "name"> 

Replace name with the name of the document you want to unlock. 

Wait. Use Wait to keep a procedure from starting until Teleworks Plus 
receives a certain string of characters from the computer or service you're 
connected to. Wait lets you make sure your computer and the computer 
or service you're connected to are synchronized before the procedure 
begins. 

Format: <Wait "text"> 

Replace text with the characters you want Teleworks Plus to wait for . 

(See "Wait for Characters" in the "Reference" section.) 

WaitCall. Use WaitCall to let another computer connect to yours. To use 
WaitCall, you have to have an auto-answering modem. 

Format: < WaitCall > 

(See "Wait for a Call" in the "Reference" section.) 
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----------Error Messages 

Bad Format. The format you've used doesn't work with the command 
you're using. 

brackets. The text in the procedure needs to be enclosed in angle 
brackets. 

Break. The procedure has been interrupted because Teleworks Plus has 
received a break. 

Busy Signal. The line is busy. Try again later. 

Disk error. The disk is damaged. Use a back-up copy or another disk. 

Disk removed. The disk containing the information Teleworks Plus 
needs isn't in the disk drive. 

File locked. You can't make changes to the me until you unlock it. 

File not found. The file you want to use isn't on the disk in the disk drive. 

Illegal Name. At least one character in the name you've typed isn't 
allowed. 

Invalid number. The number you've selected doesn't work in the en
vironment you've selected. 

Memory full. The memory space reserved for storing files, procedures, 
or the Clipboard, is full. Save the information on a disk before you go on. 

Modem does not answer. Your modem isn't turned on or it isn' t con
nected with the computer properly. Check the cables to make sure they're 
attached properly, and check the modem to make sure it's getting power. 

No dial tone. The telephone or telephone line you're using isn' t working. 

Not enough memory. There isn't enough memory in your computer to 
use Teleworks Plus. 

Option not available on demo version. The setup or function you 
want to use doesn't work with the demonstration version of Teleworks 
Plus. 
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Option unavailable. The setup or function you want to use doesn' t 
work with this version of Teleworks Plus. 

Please reboot. Start Teleworks Plus again. 

Protected disk. The write-protect notch on the disk is uncovered. 

Sub-volume not found. The folder containing the file you want isn't on 
the disk in the disk drive. 

Syntax error. There's an error in the procedure you 've just written. 
Check the syntax of the procedure against the format in Appendix A, 
''Procedure Commands.'' 

Undefined reference. The label you want the procedure to branch to 
doesn't exist. 

Unknown error. An error has occurred, but Teleworks Plus can't pin
point the problem. 

Volume full. The disk in the disk drive is full . If you want to save the file 
on the disk in the disk drive, delete files you don't want anymore from it. 
Otherwise, use a different disk. 

Volume not found. The disk containing the file you want isn't in the disk 
drive. 
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AppleTalk, 45 
ASCII transfer, 58, 67 
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Choose Printer command, 44 
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Clipboard, 22 
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signing on, 18 
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time, 10 
memory, 11 
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delete text, 21 
Dial a Number, 17 55 
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Dialing Preflx option, 16 menu bar, 9 
dialing, 16 message box, 12 
dialog boxes, 12 modem, 13 , 66 
disabling call waiting, 16 dialog box, 15 

auto-dialing, 16 
Edit Memo command, 54 mouse, 4 
Edit menu, 10, 21 
editing, Open command, 42 

a procedure, 28, 62 
text in memory, 21 Pack command, 7 1 

Erase Memo command, 54 Page Setup command, 45 
erasing text, 21 password, 19, 58 

Paste command, 53 
File menu, 10, 41 pasting text , 22 
Finder, 3, 8 Pause command, 63 
format, Print Text command, 48 

to receive data, 18, 33 printing information, 24 
to send data, 34 procedures, 

about, 25 , 29 
Good-by command, 19, 30 recording, 2 5 

editing, 28 
hang up, 20, 57 writing, 29 
Hang-up command, automatic, 59 running, 32 

Procedure commands, 28, 81 
ImageWriter, 46, 48 Procedures menu, 10, 60 
interface/modem, 13, 69 prompts, 26 

protocol, 
keyboard, 12 to receive a file, 33 
LaserWriter, 46, 47, 49 to send a file , 36 
load setup, 70 types of, 67 
local echo, 64 punctuation, 29 

macro keys, 68 Quit command, 51 
make a back-up copy, 2 quitting Teleworks Plus, 14 
memory counter, 11 
menu, receive file, 33, 35, 50 

Apple, 10 record a procedure, 25 , 60 
File, 10, 41 run a procedure, 32, 60 
Edit, 10, 21 , 

Communications, 10, 55 Save As command, 13, 23 , 43 
Procedures, 10, 60 Save Setup, 13, 20, 70 
Setup, 10, 64 
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Save command, 42 
saving information in memory, 23 
saving the file, 35 
selecting a file , 34 
Send ASCII Codes, 58 
Send a Break, 58 
Send File, 49 
sending files, 34, 36 
Setup menu, 10, 64 
sign-off, creating a procedure, 30 
signing off, 20 
start-up procedure, 62 
starting Teleworks Plus, 7 
stop recording a procedure, 60 
stop a procedure, 60 
Stop Editing Memo, 54 
syntax, 29 
sysop, 20 

time counter, 10 
transfer a file, 34, 49, 67 

Undo command, 52 
Unpack command, 71 

Wait for Characters, 26, 62 
wait for a call, 57 
windows, 11 
word wrap, 64 
write a procedure, 29, 61 

XModem, 34,67 

YModem, 67 
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